
What's in Starfish Internet Utilities Lite?
{button ,AL(`INTRO')} See also

Starfish Internet Utilities Lite: save time and money every time you go online!
Welcome to Starfish Internet Utilities Lite. With this versatile collection of utilities, you can connect 
quickly to your favorite Internet sites, unzip compressed files, track your online communications, and 
more. Internet Utilities can be easily customized to suit your working style. For example, you can 
display the Internet Utilities Control Center docked or floating, and you can use a unique feature called
SlimView to minimize the space needed by the Control Center.
Here’s what you get in Starfish Internet Utilities Lite:

QuickMarks (Lite) travels the Internet for you, performing your commands and getting information.
It helps you organize links to your favorite sites, and lets you quickly and easily save valuable data from 
the World Wide Web. 

Use the unique QuickMark It! button to create Internet QuickMark buttons with a single click. No 
more worry about bookmarking your favorite sites, or taking the time to follow your browser’s procedures 
for creating a shortcut.

InternetMeter (Lite) helps you to keep track of your communications using applications such as 
Netscape Navigator and Microsoft Internet Explorer. It monitors the status of your call, the time you spend
online, and your modem data. In addition, if a call fails, InternetMeter will show the reason, such as “Line 
busy.”

QuickZip compresses and extracts files easily and efficiently. Special features include the ability 
to quickly create self-extracting files (.exe) and drag-and-drop functionality.

Here’s what you get in the full version of Starfish Internet Utilities:
QuickMarks provides a unique Notification feature, which instantly lets you know which of your 

favorite sites have changed! You can then launch those sites with a single mouse click from the What’s 
New window!

InternetMeter includes an expanded view of your connection and data flow rate, plus you can 
customize the InternetMeter to match your own communication style and even monitor your free time with
online service providers!

QuickZip can be added and removed, along with several other plug-ins, allowing you to 
customize Internet Utilities to meet your personal needs.

InternetClock features an Internet Time Synchronizer, which precisely synchronizes your 
computer’s system clock with Internet time servers, ensuring that your system time is accurate and 
reliable. You can also use InternetClock to schedule alarms, reminders, and tasks, and display up to four 
clocks, each showing the time in a different time zone. Upgrade to get all those features!

Virtual Screens is like connecting your computer to several side-by-side monitors. You can open 
programs on the Virtual Screens, and then switch back and forth among them to work with the different 
programs. In addition, you can launch multiple instances of your browser. Then you can view one site 
while the browser in another Virtual Screen is connecting to another site.

Resources contains information about your memory, disk drive space, Windows system 
resources, and your system environment. Use the Resources utility to examine resource usage and to set
alarm levels for low resources.

Printer Manager lists all the currently installed printers, fax drivers, plotters, and other output 
devices. You can print or fax a file by dragging it to the desired printer icon, change the default printer, and
more.

WinTools offers single-click access to the most frequently used Windows 95 tools, such as Find 
and the Explorer. You can select how many and which tools you display on the Control Panel, such as 
Explorer, representing the Windows Explorer tool; Find, representing the Windows Find tool; and 
Internet Browser, representing your default Internet browser.
For details on upgrading to the full version of Starfish Internet Utilities, you can:

Call 1-888-STARFISH.
Corporate users, please call the Corporate Sales Department at 1-888-961-9696.
Visit the Starfish Software Web site: 

http: //www.starfishsoftware.com



Visit your favorite reseller.



Using Starfish Internet Utilities Lite
{button ,AL(`INTRO')} See also

Introducing Starfish Internet Utilities Lite:
fully functional!
never expires!
can be upgraded to the full version at any time! 

The full online help system is included with this lite version to give you a preview of the extensive 
functionality available when you upgrade. Topics that describe features available only in the full version
are followed in the Table of Contents by a parenthetical note: “Full Version Only.”
For information on upgrading to the full version of Starfish Internet Utilities, you can:

Call 1-888-STARFISH.
Call the Corporate Sales Department, if you are a corporate user, at 1-888-961-9696.
Visit the Starfish Software Web site: 

http: //www.starfishsoftware.com
Visit your favorite reseller.



Where to get help
{button ,AL(`INTRO')} See also

Your first source of help and information should be this online help system. In addition, Starfish 
provides other support options.

Fast fax information
Technical and product information sent directly to your fax machine in just minutes, any time of the day
or night.

800-503-3847

The Starfish BBS
Download the Technical Information notes you need, 24 hours a day.

408-461-5930

Free online information services
Discuss your questions and problems with other users and Starfish experts.

On America Online, use the keyword Starfish
On CompuServe, Go Starfish or click the CompuServe Support icon in the Starfish tab
On Microsoft Network, the Go word is Starfish

Be sure to visit our Web site for product updates, companions and news (no technical support). If you 
have Microsoft Internet Explorer, you can click the Starfish symbol below to travel to that site now.

 http://www.starfishsoftware.com

Free up and running support
No-charge assistance for installation and initial configuration.

970-522-4610, 6 a.m. - 5 p.m. Pacific Time

Support hotline
All the help you need, at $2 per minute, first minute free:

1-900-555-1010, billed to your phone bill
1-800-953-9995, charged to your credit card
6 a.m. - 5 p.m. Pacific Time



The Starfish Internet Utilities team
Special thanks to all the hard-working Starfish Software people who contributed to the creation of 
Starfish Internet Utilities!

Arlene Agcongay
Joy Agcongay

Gregg Armstrong
Allen Arumainayagam

Robert Baker
Liz Benson
Eric Bodnar

Alice Bourget
Randall Bronte
Yunming Cai

Liang-Jye Chang
Wei Chen

Chaorong Chen
Lucy Cheng

Norman Cheung
Joanne Eglash
Sasi Eswaran
Roy Feague
Brian Ferrin

Eileen Flannery
Gregor Freund

Xiang Fu
Emil Gallant

Meghadri Ghosh
Joseph Hage

Tilman Hamilton
John Hansen

Kathy Johnson
Greg Joy

Philippe Kahn
Richard King

Shekhar Kirani
Michael Lee
Jennifer Lee

Sonia Lee
Peifeng Li

Alva Lindsay



Ray Love
Lenore Luscher

Michael Ma
Paul Martinez

Christine Matthew
Tatyana Moiseyeva

Beth Nagengast
Robin Nijor 
Tom O'Brien
Dan Polinsky
Lori Poliski

Boris Polonsky
Cecilia Powell
Sandy Raney
Biddy Remick

Casten Riepling
Ian Robinson

Phil Rose
Andrew Simm

Lynn Slade
Te Smith

Linda Soohoo
Mary Taylor

J.T. Teh
Perry Tobin

Andy Van Valer 
Elena Veligurova
Charlie Wallace
Jennifer Walsh

Ye Wang
Song Wang
Hui Wang

Joy Warner
Steve White
Dave Wolfer

Suki Woodward
TeamS (Don, Harry, Barry, Charlie, Marilyn & Jim)

Yonghe Yao
Yang (Walter) Yu

Qili Zhang





Utilities
{button ,AL(`WHATS_ON')} See also
The eight utilities in Starfish Internet Utilities are “plugged into” the Starfish Internet Control Center.    
You can rearrange utilities on the Control Center, “hide” utilities that you don’t need to use, and even 
reduce the space needed by the Control Center by using SlimView.    (Depending on your version of 
Starfish Internet Utilities, not all features described in this help system may be available to you. For 
details on obtaining the full product, see Versions of this product.)
In addition, you can:

snap some plug-in utilities on and off the Control Center for easier access.
control the size of some plug-in utilities, and even hide them if you want.
rearrange items on each utility, and rearrange plug-in utilities on the Control Center itself.



Menus
{button ,AL(`WHATS_ON')} See also

Menus are pull-down lists of commands you can use.
Starfish Internet Utilities provides three menus to help you work in the Windows environment:

Access typical Windows functions with the System menu.
Get online help with the Help menu, either by selecting the Contents menu item or by clicking the 

What Is This? menu item.    If you click that menu item, the pointer becomes shaped like a question mark. 
You can then click the pointer on an object for which you want more information.

Use the Layout menu to save your Starfish Internet Utilities screen layout
the placement and size of applications in the Virtual Screens
and to manage other previously saved layouts.
In addition, each utility has a shortcut menu that offers the fastest way to use its features. Right-click 
the utility to see its shortcut menu, and then choose the command you want.



Buttons
{button ,AL(`WHATS_ON')} See also

Buttons are icons you click to control Starfish Internet Utilities.
Buttons let you snap some utilities on and off, start Help and programs, start World Wide Web browser 
searches, and open the Customize dialog box. You can click the QuickRun button, for example, to 
display a command line and a DOS command window from which you can execute DOS and Windows
95 commands.
In addition, the QuickMarks utility contains three special buttons: Manage QuickMarks, Find 
QuickMark, and What’s New. Use these buttons to manage and search through your QuickMarks 
programs, Internet sites, and other items, such as documents.



Shortcut menus
{button ,AL(`WHATS_ON')} See also

A utility's shortcut menu is usually the fastest way to work. You can right-click any utility to open its 
shortcut menu. Each utility’s shortcut menu lists all the options available, and these menu items 
represent the quickest way to perform those tasks.
For example, to customize the Virtual Screens utility, you can either right-click the utility and choose 
Customize from the shortcut menu, or you can click the Customize button, and then select Virtual 
Screens from the Plug-Ins list in Customize.



Rearranging utilities
{button ,AL(`TASKS_GLOBAL')} See also

To change the position of utilities on the Control Center
1. Open the Customize dialog box.
2. Drag a utility up or down in the list to change its position on the Control Center.

The higher up a utility is on the list, the farther to the left it appears on the Control Center.



Showing and hiding utilities
{button ,AL(`TASKS_GLOBAL')} See also

To show or hide a utility
1. Click the Customize button to open the Customize dialog box.
2. Click a utility in the Plug-Ins list, and then check or uncheck the Show box on its Customize page.
Hiding a utility removes it from view, but it remains in memory. You can also remove a utility from view 
and memory, or add a utility that has been removed.    See Adding and removing utilities.



Adding and removing utilities
{button ,AL(`TASKS_GLOBAL')} See also

To add or remove a utility from memory
1. Click the Customize button and open the Customize dialog box.
2. Select My Setup in the Plug-Ins list.
3. Click the Plug-Ins tab.
4. Select a utility from the Available list and click Add to display it on the Control Center and add it to 

memory.    Or, select a utility from the Installed list and click Remove to remove it from memory and 
from the Control Center.

You can also hide a utility rather than remove it from memory. See Showing and hiding utilities.



Snapping utilities off and on
{button ,AL(`TASKS_GLOBAL')} See also

To snap a utility off or on, either:
Right-click the utility. Select Position from the shortcut menu, and use the Position submenu 

options.
Click the utility’s Snap Off/On button at the left of the Control Center.



Starting programs with QuickMarks buttons
{button ,AL(`LAUNCHING')} See also

To start a program with a QuickMarks button, do any of the following:
Click the program’s QuickMarks button.
Type its hot key sequence.

See Changing the properties of a QuickMarks button for details on how to set a hot key sequence.



Starting programs with the Layout menu
{button ,AL(`LAUNCHING')} See also

To start a program with the Layout menu
1. Click .

The list of available layouts appears.
2. Choose a layout from the list.

You automatically start all programs saved as part of that layout. They are placed in the same 
positions on the Virtual Screens that they occupied when the layout was saved. If a program was 
minimized when it was saved as part of a layout, it will be minimized when that layout is opened.



Starting programs with QuickRun
{button ,AL(`LAUNCHING')} See also

To start a program with the QuickRun dialog box
1. Click the QuickRun button.

The QuickRun window appears.
2. Enter the name of the program you want to run.

See Entering DOS commands in QuickRun.
3. Check Run Minimized if you want to run the program minimized.
4. Click the QuickRun button.
5. After the program starts, select QuickRun again.

Hold down the Alt key and press Tab until QuickRun appears.



Managing open programs
{button ,AL(`LAUNCHING')} See also

In addition to the Virtual Screens, Starfish Internet Utilities gives you two ways to keep track of your 
currently running programs, or tasks, and to switch between them.

The Taskbar
The Taskbar contains a button for each task. Clicking the button instantly activates that task. You can 
use the Taskbar as a part of the Control Center or as a snapped-off utility.

The Task Manager
You can use the Task Manager to:

Switch to open programs.
Close selected programs.
Tile or cascade your program windows.
Display information about a program.



Saving and creating setups
{button ,AL(`CONFIGURATIONS')} See also

To save or create a setup
1. Click the Customize button to open the Customize dialog box.
2. Select My Setup (or the current setup file name) at the top of the Plug-Ins list.
3. Click the Setup tab.    You can:

click the drop-down list to choose from the setups that are included with Starfish Internet Utilities, 
or to switch to one of your saved setups.

click Save to save and name your current setup.    That name is then added to the drop-down list.



Loading a setup
{button ,AL(`CONFIGURATIONS')} See also

To use a Starfish Internet Utilities setup that you've previously created and saved
1. Click the Customize button to open the Customize dialog box.
2. Select My Setup (or the current setup file name) at the top of the Plug-Ins list.
3. Click the Setup tab and choose the setup you want from the drop-down list.



Using keyboard shortcuts
{button ,AL(`TIPS')} See also

You can operate Starfish Internet Utilities with the keyboard as well as the mouse.
The following hot keys are available when you install Starfish Internet Utilities; you can also configure 
hot keys to perform other tasks.

F12
Bring the Control Center to the front of other windows or, if the Control Center is already in front, send 
it to the back of all other windows. (F12 is the default key for this function. You can use the Hot Key 
preferences in the Customize dialog box to set another hot key for this function.)

Alt+(character)
Choose a button or menu command that has its selection character underlined. For example, if a 
button is labeled Add, the letter A is the letter for selecting the Add key, and pressing Alt+A is 
equivalent to clicking the button.

Alt+Spacebar
Show the System Menu.

Ctrl+F6
Cycle through Starfish Internet Utilities and any open dialog boxes and snapped-off utilities.

Arrow Keys (up/down/left/right)
Select items from menus and from groups within a dialog box. If you use Tab to select an item on the 
Control Center, using the cursor keys will cycle through individual components of the items.

End
Move to last item on a list.

Enter
Equivalent to double-clicking the mouse on the selected item. In a dialog box, equivalent to clicking on 
the OK button.

Esc
Exit a menu. Cancel out of a dialog box.

Home
Move to first item in a list.

Spacebar
When you press Tab or Shift+Tab to select a Control Center item, the keyboard focus is then on that 
item. Pressing the spacebar then selects that item. Using the spacebar is equivalent to clicking the 
mouse.

Tab
When the Control Center has focus, use the Tab key to cycle through the utilities. When a dialog box is
active, the Tab key cycles through groups in it. 

Shift+Tab
Cycles through the reverse direction of the Tab key.



Using the Readme file
{button ,AL(`TIPS')} See also

Starfish Internet Utilities installs a Readme file, Readme.txt.
This Readme file contains supplemental information, and should be reviewed when you install Starfish 
Internet Utilities.



Removing Starfish Internet Utilities
{button ,AL(`TIPS')} See also

To remove Starfish Internet Utilities from your system
1. If Starfish Internet Utilities is running, close it.    Right-click the InternetMeter system tray icon and 

select Close InternetMeter from the shortcut menu to close the call monitoring module.
2. Open the Windows 95 Control Panel.
3. Select Add/Remove Programs, and then select Starfish Internet Utilities from the list.
4. Click the Add/Remove button.



Starting programs with an alarm
{button ,AL(`LAUNCHING')} See also

To set an alarm to start a program
1. Right-click the InternetClock and choose Schedule Task.

The InternetClock Task dialog box opens.
2. In the Date section, choose a single date or schedule the task to repeat daily, weekly, or monthly. To 

set a date, use the arrows or type a number in the box.
3. In the Time section, choose the time and time zone for the task, or set it to repeat every so many 

minutes. To set a time, use the arrows or type a number in the box.
4. In the Task section, enter the program's name, command, and directory path. You can click the 

Browse button to find the program you want.
5. Check the Run Minimized box if you want the program to run minimized.
For more information, see Events page.



Versions of this product
{button ,AL(`INTRO')} See also

You can customize Internet Utilities to suit your personal style by adding and removing the utilities, 
also referred to as plug-ins. Not all utilities are installed when you first start Internet Utilities. For 
information on adding utilities, see Adding and removing utilities.
In addition, depending on your version of Starfish Internet Utilities, not all features described in this 
help system may be available to you. After you have purchased and registered the full product, all 
features will become available.
For information on registration and/or details about purchasing the complete product, see the Starfish 
Software Web site at http://www.starfishsoftware.com.



Customizing a utility
{button ,AL(`DASH_PREFS')} See also

You can customize a utility using the utility’s shortcut menu or the Customize dialog box.

To customize a utility using the shortcut menu
1. Right-click a utility to display its shortcut menu.
2. From the shortcut menu, choose a menu item or choose Customize.

To customize a utility using the Customize dialog box
1. Click  to open the Customize dialog box.

2. In the Plug-Ins list, double-click a plug-in utility name.    The list expands, allowing you to view the 
different Customize options.
3. Specify preferences for the utility.



Opening the Customize dialog box
{button ,AL(`DASH_PREFS')} See also

You specify preferences for all utilities in the Customize dialog box.

To open the Customize dialog box
Do one of the following:

Right-click the title bar and choose Customize.
Click 



Specifying hot keys to activate Starfish Internet Utilities, the Explorer, and QuickRun
{button ,AL(`DASH_PREFS')} See also

You can specify a hot key to activate Starfish Internet Utilities, the Explorer, or QuickRun. If the one 
you switch to is minimized, behind other windows, or in another Virtual Screen, the hot key brings it to 
the front and switches to the proper Virtual Screen.
1. Click  to open the Customize dialog box.

2. Double-click Control Center, and then click Hot Keys.
3. In the box next to each item, enter the hot key sequence.



Reducing the space needed by the Control Center
{button ,AL(`DASH_PREFS')} See also

Internet Utilities lets you minimize the space needed by the Control Center with a unique feature: 
SlimView. In SlimView, only the QuickMark tabs are displayed.
To use SlimView
1. Click the Customize button, and double-click Control Center.
2. Click Arrangement.
3. Dock the Control Center to an edge, and then check SlimView.
To display the full Control Center, click a tab or the Control Center edge. If you want the Control Center
to remain in full size, click the SlimView button.     You also have the option of hiding the QuickMarks 
tabs in SlimView. For details, see Changing the Control Center appearance.



Changing the title bar
{button ,AL(`DASH_PREFS_APPEARANCE')} See also

To specify what to display on the title bar
1. Click  to open the Customize dialog box.

2. Click Control Center.
3. The Control Center page is displayed.
4. Click the drop-down list to change the title bar.





Changing the Control Center position
{button ,AL(`DASH_PREFS_APPEARANCE')} See also

You can dock the Control Center to one edge of your screen, or place it in a vertical or horizontal 
floating position:
1. Right-click the title bar.
2. Choose Position from the shortcut menu.
3. Choose Horizontal Floating, Vertical Floating, Top Edge, Bottom Edge, Left Edge, or Right Edge. If 

you dock the Control Center to one edge of your screen, you can also use SlimView.
If you resize the vertical Control Center, some utilities adjust to fit in the space you've defined.



Changing the Control Center appearance
{button ,AL(`DASH_PREFS_APPEARANCE')} See also

You can customize the appearance of the Control Center to suit your personal working style.

To change the Control Center appearance
1. Click  to open the Customize dialog box.

2. Double-click Control Center, and then click Appearance.
3. If you want controls on the Control Center to highlight when you move the mouse over them, 
check Show Highlights. 
4. To display the QuickMarks tabs in SlimView, check Show Tabs. If you do not check this box, only 
a thin gray bar appears at the edge of your screen. (Click a tab or move the mouse over the gray bar to 
restore the Control Center to full size.)

5. If you want the Control Center to slide into place when it is in SlimView, check Slide the Control 
Center. If you do not check this box, the Control Center pops up when you change views.





About QuickMarks
{button ,AL(`QUICK_LAUNCH')} See also

Use the QuickMarks utility to create buttons for your most frequently used Internet sites, programs, 
and other items. You can group your QuickMark buttons by using tabs that appear on the Control 
Center. Click on a tab to see the QuickMarks buttons in that group. For example, you might have a tab 
called News that, when you click it, gives you one-click access to News-related Internet sites.
You can add new QuickMarks buttons and tabs to the Control Center and even import and export 
QuickMarks groups by clicking the  Manage QuickMarks button.
You can:

Click a QuickMarks button to jump to a Web site, start a program, or open a document. When you
click an Internet QuickMarks button, it launches your browser and connects you to that site. After your 
browser is launched, you can continue to click different QuickMarks buttons to connect quickly to those 
sites.

Start a program by dragging its QuickMarks button to one of the Virtual Screens.
Use the unique QuickMark It! button to create Internet QuickMark buttons with a single click. No 

more worry about bookmarking your favorite sites, or taking the time to follow your browser’s procedures 
for creating a shortcut. You can also add new QuickMarks buttons for applications and documents. For 
details, see Adding QuickMarks.

Save (export) QuickMarks and e-mail them to friends, as well as import new QuickMarks.
Snap off the QuickMarks utility and display it as a floating palette.
Receive automatic notification of updated and removed QuickMarks items. A QuickMark button 

marked with a starburst means that it is updated. If an X is displayed on a QuickMark button, it indicates 
that the item is removed (as with a document) or broken in some way (for example, an Internet site’s link 
might have changed, or the server might be temporarily down).

The AppOrganizer
When you first run Starfish Internet Utilities, the AppOrganizer searches for applications, Netscape 
Navigator Bookmarks and Microsoft Internet Explorer Favorites, and other items on your hard disk, 
creates QuickMark buttons for those items, and places them in tabs on your QuickMarks utility. Internet
Utilities automatically synchronizes your Bookmarks and Favorites. Or, if you prefer, you can manually 
synchronize them. For details, see Synchronizing your Bookmarks and Favorites.

QuickMarks Read-Only Folders
Your Bookmarks, Favorites, Desktop, and Documents folders are read-only. This means that you 
cannot delete items from or add items to those folders. In addition, you can create read-only folders by 
using the Export QuickMarks menu option on the Manage QuickMarks menu.

QuickMarks tool buttons
In addition to the QuickMark It! button described above, the QuickMarks utility contains these tool 
buttons:

Manage QuickMarks performs tasks ranging from adding new tabs to adding new QuickMarks 
items to a group.

Find QuickMark searches for a specific QuickMarks item.
What’s New displays which QuickMarks items have changed, such as an updated Web site.

Note: Starfish Internet Utilities includes QuickMarks and logos representing World Wide Web pages of
various companies other than Starfish.    The inclusion of those QuickMarks and logos does not 
necessarily mean that Starfish or those companies endorse each other's products or services.    
Starfish and the Starfish logo are trademarks of Starfish Software, Inc.    Infoseek, Infoseek 
Guide, Infoseek Personal, iZone and the Infoseek logo are trademarks of Infoseek Corporation.  
AltaVista is a trademark of Digital Equipment Corporation.    Other brand and product names and
logos are trademarks or registered trademarks of their respective holders.



Showing and hiding the QuickMarks utility
{button ,AL(`QUICK_LAUNCH')} See also

To show or hide the QuickMarks utility
1. Click  to open the Customize dialog box.

2. Click QuickMarks in the Plug-ins list.
3. Check the Show box to display the QuickMarks utility on the Control Center, or uncheck the Show
box to hide it from view.



Snapping the QuickMarks utility on and off
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

You can snap off the QuickMarks utility and display it as a floating palette, or you can dock it to one 
side of your screen.
You use the QuickMarks utility in the same way whether it is on the Control Center or snapped off.

To snap the QuickMarks utility off or on, either:
Click 

Right-click the QuickMarks utility and choose Position from the shortcut menu.    Choose the new 
position from the submenu.



Docking the QuickMarks utility to the edge of your screen
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

You can dock the QuickMarks utility to any edge of your screen.

To dock the QuickMarks utility
Do any of the following:

Right-click the snapped-off QuickMarks utility and choose Position from the shortcut menu.    
Select the desired new position (Top, Bottom, Left, or Right) from the submenu.

On the QuickMarks Position page in the Customize dialog box, click one of the following:
Docked to Top
Docked to Left
Docked to Right
Docked to Bottom



Rearranging buttons and tabs on the QuickMarks utility
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

To move a QuickMarks button to a new location on the utility, drag the QuickMarks button to a new 
position on the utility.
To rearrange tabs, right-click a tab and select Sort Tabs from the shortcut menu. You can sort tabs 
alphabetically, or by color or by use.



Specifying the button style
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

To specify a style for QuickMarks buttons
1. Click  to open the Customize dialog box.

2. Double-click QuickMarks, and then click Settings in the Plug-Ins list.
3. Click the Settings page tab.
4. Choose a button style:

Unlabeled displays only icons on the buttons.
Labeled displays icons and application names on the buttons.



Resizing the QuickMarks utility
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

To resize the QuickMarks utility when it is snapped on, hold down the Shift key and move the cursor to 
either edge of the utility. When the cursor changes to a sizing arrow, resize the utility. The utility 
displays as many buttons as possible in the space you've defined.



Adding QuickMarks
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

You can add QuickMarks buttons for your favorite Internet sites quickly and easily, so that a click of a 
button takes you to a Web site. You can also create QuickMarks buttons for applications and 
documents. For details on creating QuickMark buttons directly from an open Web page, see 
QuickMarking Your Current Web Page.
To create a QuickMark: 
1. Click the Manage QuickMarks button  and click New QuickMark on the menu.

2. Select the item type (Application, Document, or Internet).
3. The Properties dialog box opens. Enter a title for the new QuickMarks button and, if desired, a hot
key for it. Click Change Icon to select an icon for the button.
4. To have the QuickMarks button included in the notification process, check the “Check for Periodic
Changes box.”
5. If the item is:

an application, click the Application tab to enter the name of the program and its directory.
an Internet site, click the Internet Site tab if you want to view the last update and location (URL) of

an Internet site item 
a document, click the Document tab to enter its filename.

To create a QuickMark by dragging
1. Select the file or shortcut from the Explorer, a window, or the desktop.
2. Drag the item to the QuickMarks utility. 
In addition, you can create an Internet QuickMark by using a shortcut method. For details, see Adding 
Internet QuickMarks buttons. 



Deleting QuickMarks and QuickMarks tabs
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

You can delete QuickMarks buttons and/or tabs quickly and easily.
To delete a QuickMark: 
1. Right-click the QuickMarks button that you do not want.
2. Click Delete on the menu.
To delete a QuickMark tab: 
1. Right-click the QuickMarks tab that you do not want.
2. Click Delete Current Tab on the menu.



Changing the properties of a QuickMarks button
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

To change a QuickMarks button’s properties:
Right-click the button and select Properties from the shortcut menu.

You can use the Properties dialog box to:
change the title of a QuickMarks button.
enter or change a hot key for it.
select a new icon for the button (click Change Icon).
have the QuickMarks button included in the notification process (check the “Check for Periodic 

Changes box.”)
In addition, if the item is:

an application, click the Application tab to enter the name of the program and its directory.
an Internet site, click the Internet Site tab if you want to view the last update and location (URL) of

an Internet site item. 
a document, click the Document tab to enter its filename.



About the Manage QuickMarks button
{button ,AL(`QUICK_LAUNCH')} See also

Use the Manage QuickMarks button to add, delete, and modify your QuickMarks tabs on the Control 
Center. You can also create new QuickMarks buttons and even import and export QuickMarks groups.

When you click the Manage QuickMarks button  on the QuickMarks utility, the Manage QuickMarks 
menu is displayed.

The Manage QuickMarks menu
From the Manage QuickMarks menu, select:

New Tab to add a new QuickMarks tab to the Control Center. Enter a name for the tab, and 
choose a color (optional) and type from the drop-down lists. See Creating new QuickMarks tabs for more 
information.

Modify Current Tab to change the currently selected tab’s name or color.
Delete Current Tab to remove the currently selected tab from the Control Center.
New QuickMark to add a new QuickMark button to the currently selected tab. For details, see 

Adding QuickMarks.
Import QuickMarks to add a new QuickMarks group from the CoolMarks database to the Control 

Center. The CoolMarks database, which contains useful and interesting Web sites, is included with 
Starfish Internet Utilities, and you can also import .cmk files that you received from friends. For details, 
see Importing QuickMarks.

Export QuickMarks to save a QuickMarks group and, if desired, even e-mail it to a friend. For 
details, see Exporting QuickMarks.

AppOrganizer to run the AppOrganizer and update your QuickMarks utility. For details, see About 
the AppOrganizer.



Creating new QuickMarks tabs
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

To create a new QuickMarks tab
1. Click the Manage QuickMarks button  and select New Tab from the menu.

2. Enter a name for the new tab, color if desired, and tab type. For the tab type, choose:
Desktop Folder if the tab will contain QuickMarks buttons representing items on your desktop.
Recent Documents if the tab will contain QuickMarks buttons representing the documents in your 

Windows 95 Start menu’s Documents option. 
Navigator Bookmarks if the tab will contain QuickMarks buttons representing your Netscape 

Navigator Bookmarks.
Explorer Favorites if the tab will contain QuickMarks buttons representing your Microsoft Internet 

Explorer Favorites.
QuickMark Folder for all other types of items.

3. The new tab appears on the Control Center.
Note: To modify or delete a tab, right-click that tab and use the shortcut menu. You can also use that 

menu to sort your tabs alphabetically or by color or use. For details on adding a new folder to a 
QuickMark group, see Creating new QuickMarks folders.



Importing QuickMarks
{button ,AL(`QUICK_LAUNCH_USING')} See also

To import QuickMarks from the CoolMarks database
1. Click the Manage QuickMarks button  on the Control Center and click the Import QuickMarks 

menu item.
2. The Import QuickMarks dialog box appears, showing you the available CoolMark files on your 
system. (The CoolMarks database, which contains useful and interesting Web sites, is included with 
Starfish Internet Utilities, and you can also import .cmk files that you received from friends and colleagues
who use Internet Utilities.)    Enter the desired file name, such as sample.cmk, and click Open.

3. A new tab and the items in that file are added to the Control Center. To view the new QuickMarks 
group, click that tab.

Note: If you import a file that is read-only, you cannot add items to or delete items from that file.



Exporting QuickMarks
{button ,AL(`QUICK_LAUNCH_USING')} See also

To export QuickMarks and save them in the CoolMark Database (.cmk) format
1. Select the tab that you want to export and click the Manage QuickMarks button  on the Control 

Center. Click the Export QuickMarks menu item.
2. Enter a name for the file, such as fun, and a description.
3. Check the Export QuickMarks in Sub-Folders box to include any folders within that tab, and click 
Export.
4. Choose the directory in which to save your CoolMarks database (.cmk file), and enter a name for 
that file. Check the Open as Read-Only box if you want to create a read-only .cmk file. Click Save.

Note: If you export a folder that is read-only, items cannot be added to or deleted from that folder.
The new .cmk file is now on your system in the directory that you selected, ready for you to e-mail to a 
colleague or friend who also has Starfish Internet Utilities. That person can use the Import 
QuickMarks menu option on the Manage QuickMarks menu to view the contents of the new file.



About the What’s New window
{button ,AL(`QUICK_LAUNCH')} See also

View a list of items that have been tagged as changed by the QuickMarks Notification feature. For 
details about the automatic verification and notification process, see Notification.

To display the What’s New window, click the What’s New button  on the QuickMarks utility. When 
the button is animated, it means What’s New has found a QuickMark that has changed. To stop the 
animation, click the What’s New button.

What’s New window
The What’s New window displays all your changed QuickMark items, such as a Web site that has 
been updated.
You can launch an item in this window by double-clicking it.
Note: When QuickMarks is verifying a QuickMarks button, a “secret agent” icon appears on that 

button. When you have a changed item, the What’s New button on the QuickMarks utility 
becomes animated.



About the Find QuickMark window
{button ,AL(`QUICK_LAUNCH')} See also

Find items in your QuickMarks by searching for titles or text. 

To display the Find QuickMark window, click the Find QuickMark button  on the QuickMarks utility.

The Find QuickMark window

Find
Enter a text or title. Find does not process wildcards, whole strings, or regular expressions.

Case-Sensitive Search
Searches for the context string or title with attention to capitalization.

Search Titles Only
Limits the search to the titles of QuickMarks items.

Search Titles and Contents
Searches for the titles and contents of items, such as a text in a document.

Find
Click to start the search. If no QuickMark item matches the search criteria, a message box indicating a 
search failure is shown.
The name of the item(s), last date updated, and item type (such as Internet QuickMark) appears in the 
window. 



Creating new QuickMarks folders
{button ,AL(`QUICK_LAUNCH_APPEARANCE')} See also

To create a new QuickMarks folder
1. Click the tab of the group for which you want to create a new folder. For example, if you want to 

create a folder to contain Internet sites related to buying a house, you might click a tab entitled 
Finance. For details on creating a new tab, see Creating new QuickMarks tabs.

2. Right-click inside that group, select New, and then click Folder on the shortcut menu. Enter the title 
of the new folder, such as Houses, in the dialog box.

The new folder will appear in the selected tab. Click the folder to open it and add items to it. Click the 
Back icon to move up to the top level of that group and close the folder.



About the AppOrganizer
{button ,AL(`QUICK_LAUNCH')} See also

When you first run Starfish Internet Utilities, the AppOrganizer searches for applications, creates 
buttons for them, and puts them into different groups on the QuickMarks utility, with a separate tab 
representing each group of buttons. In addition, Starfish Internet Utilities creates a variety of Internet-
related QuickMarks tabs, such as Search and News, with six to ten QuickMarks buttons in each 
category.    You’ll find your Internet “Bookmarks,” if you are using Netscape Navigator, and/or 
“Favorites,” if you are using Microsoft Internet Explorer, are also automatically added to the 
QuickMarks utility, depending on which browser you have. You can choose whether to have them 
manually or automatically synchronized.
You can run the AppOrganizer at any time after you have installed by using the Manage QuickMarks 
menu. This will update your QuickMarks utility.

To run the AppOrganizer
1. Click the Manage QuickMarks button and select AppOrganizer from the menu.
2. Check Add Internet Sites to import additional Internet sites into QuickMarks.
3. Check Organize Installed Applications to have the AppOrganizer organize your applications into 

QuickMarks folders. 





Selecting your browser
{button ,AL(`QUICK_LAUNCH')} See also

When you click a QuickMarks button, your default browser is launched. You can select a different 
browser for launching your QuickMarks buttons.

To select a different browser
1. Click  to open the Customize dialog box.

2. Double-click QuickMarks in the Plug-ins list, and then click Settings.
3. Click the Advanced button. In the Browser page in the Advanced Settings dialog, select Netscape
Navigator or Microsoft Internet Explorer as the browser that you want to use when launching QuickMarks.



Synchronizing your Bookmarks and Favorites
{button ,AL(`QUICK_LAUNCH')} See also

Starfish Internet Utilities synchronizes your Netscape Navigator Bookmarks and Microsoft Internet 
Explorer Favorites. You can have Internet Utilities do this procedure automatically, or, if you prefer, you
can manually synchronize your Bookmarks and Favorites.

To select your synchronization method
1. Right-click the Bookmarks or Favorites tab on the Control Center.
2. Click Synchronization.
3. Click:

Auto Synchronize to set up automatic synchronization.
Import to manually add your new Bookmarks or Favorites to your QuickMarks tab.
Export to send any additional QuickMarks that you have added to your Bookmarks or Favorites 

tab to your browser. For example, if you have received a set of “CoolMarks” from a friend, you can place 
them in your Bookmarks or Favorites tab. Then click Export to send them to your browser. (Depending on 
your browser, you may see a dialog prompt, to which you must reply before the QuickMarks can be 
exported.)



About WinTools
{button ,AL(`WIN_TOOLS')} See also

The WinTools utility offers single-click access to the most frequently used Windows 95 tools, such as 
Find and the Explorer.
You can select how many and which tools you display on the Control Panel, such as:    
Explorer, representing the Windows Explorer tool.
Find, representing the Windows Find tool.
Inbox, representing your e-mail inbox.
Internet Browser, representing your default Internet browser.
Log Off, representing the Close All Programs and Log On as a Different User command on your Start 
menu.
Restart, representing the Restart the Computer command on your Start menu.
Shut Down, representing the Shut Down the Computer command on your Start menu.
Task Manager, representing the Starfish Internet Utilities Task Manager.
Control Panel, representing the Windows 95 Control Panel.
Network Neighborhood, representing your computer system’s network.
Printers, representing your printers.
Recycle Bin, representing your computer’s Recycle Bin.
My Computer, representing your computer.
Note: “Prompted” versions of the above tools will display a dialog box asking you to confirm the action.



Showing and hiding WinTools
{button ,AL(`WIN_TOOLS')} See also

To show or hide the WinTools utility
1. Click  to open the Customize dialog box.

2. Click WinTools in the Plug-Ins list.
3. Check the Show box on the WinTools page.



Changing the tools on the WinTools utility
{button ,AL(`WIN_TOOLS')} See also

You can choose which tools and how many tools you display on the WinTools utility.

To change the tools that are displayed
1. Click  to open the Customize dialog box.

2. Double-click WinTools in the Plug-Ins list, and then click Tools.
3. Select a tool from the Available Tools list and click Add to display it on the WinTools utility.    To 
remove a tool, select it from the Installed Tools list and click Remove.



About the Resources utility
{button ,AL(`RESOURCES')} See also

The Resources utility contains information about your memory, disk drive space, Windows system 
resources, and your system environment. Use the Resources utility to examine resource usage and to 
set alarm levels for low resources.
The Resources utility can contain up to three sections:

Memory Watch
CPU Meter
Drive Watch

In addition, Starfish Internet Utilities monitors other system resources that are displayed only in the 
Resources dialog box:

System Environment
Applications Running
Environment Variables

For information on using the Resources utility, click See Also or click >> to browse through the topics.



Showing and hiding the Resources utility 
{button ,AL(`RESOURCES')} See also

To show or hide the Resources utility 
1. Click  to open the Customize dialog box.

2. Click Resources to display preferences for the Resources utility.
3. Check or uncheck the Show box.



Displaying the Resources dialog box
{button ,AL(`RESOURCES')} See also

To display the Resources dialog box
Do either of the following:

Double-click the Resources utility.
Right-click the Resources utility and select Details from the shortcut menu. 



About the Memory Watch
{button ,AL(`RESOURCES_GAUGE')} See also

The Memory Watch displays the amount of available memory you have.
Each running program uses up a portion of system memory. The Memory Watch displays the 
percentage of swappable system memory. The meter drops toward empty as the percentage of 
available memory decreases.
For information on using the Memory Watch, click See Also or click >> to browse through the topics.



Viewing memory and resource information
{button ,AL(`RESOURCES_GAUGE')} See also

To view memory and resource information
Do either of the following:

Display the Memory Watch on the Resources utility.
See Showing and hiding the Memory Watch.
Display the Resources dialog box.
See Displaying the Resources dialog box.



Showing and hiding the Memory Watch
{button ,AL(`RESOURCES_GAUGE')} See also

To show or hide the Memory Watch 
1. Click  to open the Customize dialog box.

2. Click Resources to display preferences for the Resources utility.
3. Check or uncheck the Show the Memory Watch box.



Changing the appearance of the Memory Watch
{button ,AL(`RESOURCES_GAUGE')} See also

You can display the Memory Watch as different gauge types.

To change the appearance of the Memory Watch
1. Click  to open the Customize dialog box.

2. Click Resources to display preferences for the Resources utility.
3. In the Resource Gauges section, check Show Memory Watch, and then choose the gauge you 
want from the drop-down list. 



Viewing system resources
{button ,AL(`RESOURCES_GAUGE')} See also

To view system resources
1. Double-click the Resources utility, or right-click it and click Details in the shortcut menu.
2. Click Memory Watch in the Select Item to View list.



Sounding an alarm for low memory
{button ,AL(`RESOURCES_GAUGE')} See also

You can set an alarm to sound when the available memory reaches the warning values you specify. 
You can set alarms to be notified both when the system memory falls below a certain percentage free 
and when any memory area falls below a certain percentage free. For example, if you enter 20 for the 
system memory alarm level, an alarm sounds when the system memory is below 20 percent free.

To set up a memory alarm
1. Click  to open the Customize dialog box.

2. Double-click Resources in the Plug-Ins list.
3. Click Memory Watch.
4. Check the warning boxes, and enter warning values in the % Free boxes.
5. Choose the type of sound to use as the alarm.



Printing memory and resources statistics
{button ,AL(`RESOURCES_GAUGE')} See also

To print memory and resources statistics
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click Memory Watch.
3. Click Print.



Viewing system environment information
{button ,AL(`RESOURCES_SYSTEM_ENVIRONMENT')} See also

You can view information about your computer, such as the processor type, display type, and output 
devices.

To view system environment information
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click System Environment.



Printing system environment statistics
{button ,AL(`RESOURCES_SYSTEM_ENVIRONMENT')} See also

To print system environment statistics
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click System Environment.
3. Click Print.



About the Drive Watch
{button ,AL(`RESOURCES_DRIVES')} See also

The Drive Watch displays the available disk space for drives that you specify on the Drive Watch page 
of the Customize dialog box.
You can monitor floppy drives, hard disk drives, and network drives.
For information on using the Drive Watch, click See Also, or click >> to browse through the topics.



Viewing drive usage information
{button ,AL(`RESOURCES_DRIVES')} See also

To view drive usage information
Do either of the following:

Display the Drive Watch on the Resources utility.
See Showing and hiding the Drive Watch.
Display the Resources dialog box and click Drive Watch.
See Displaying the Resources dialog box.



Showing and hiding the Drive Watch
{button ,AL(`RESOURCES_DRIVES')} See also

To show or hide the Drive Watch when the Resources utility is displayed
Right-click the Resources utility and check or uncheck Show Drive Watch.

To show the Drive Watch when the Resources utility is hidden
1. Click  to open the Customize dialog box.

2. Click Resources to display preferences for the Resources utility.
3. Check the box labeled Show the Resource Monitor.
4. Check the Show Drive Watch box.



Updating the list of available drives
{button ,AL(`RESOURCES_DRIVES')} See also

You can update the list of available drives. For example, if you attach to another network drive, you 
might want to update the list of available drives.

To update the list of available drives
1. Click  to open the Customize dialog box.

2. Double-click Resources, and then click Drive Watch.
3. In the Drive Watch section, click Refresh List.



Setting an update interval for the Drive Watch
{button ,AL(`RESOURCES_DRIVES')} See also

Information in the Drive Watch is updated at whatever interval you specify.
Note: The update interval might affect performance, especially with large network drives. Experiment 

with various settings to determine the optimum interval for your system.

To set the update interval
1. Click  to open the Customize dialog box.

2. Double-click Resources, and then click Drive Watch.
3. Click a drive. 
4. Enter a value in seconds in the Update Interval box and click Start Watch.



Printing drive usage statistics
{button ,AL(`RESOURCES_DRIVES')} See also

To print drive usage statistics
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click Drive Watch.
3. Click Print.



Viewing information about running applications
{button ,AL(`RESOURCES_APPLICATIONS')} See also

You can view currently open applications and their memory usage.

To view information about running applications
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click Applications Running.



Closing running applications
{button ,AL(`RESOURCES_APPLICATIONS')} See also

To close a running application
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click Applications Running.
3. Select the application that you want to close.
4. Click Close Application.



Updating the application list
{button ,AL(`RESOURCES_APPLICATIONS')} See also

To update the list of running applications
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click Applications Running.
3. Click Refresh.



Printing running application statistics
{button ,AL(`RESOURCES_APPLICATIONS')} See also

To print running application statistics
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click Applications Running.
3. Click Print.



Viewing environment variables information
{button ,AL(`RESOURCES_ENVIRONMENT_VARS')} See also

You can view the environment variables your system is currently using.

To view environment variables
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click Environment Variables.



Printing environment variables statistics
{button ,AL(`RESOURCES_ENVIRONMENT_VARS')} See also

To print environment variables statistics
1. Double-click the Resources utility, or right-click it and select Details from the shortcut menu.

The Resources dialog box appears.
2. Click Environment Variables.
3. Click Print.



About the CPU Meter
{button ,AL(`RESOURCES;RESOURCES_CPU')} See also

The CPU Meter displays the following information about your system:
CPU activity tells you how busy your central processing unit is.
Threads show simultaneous activities.
VM indicates your virtual machines. For example, Windows 95 is one virtual machine, and each 

DOS window is another virtual machine. 



Showing and hiding the CPU Meter
{button ,AL(`RESOURCES_CPU')} See also

To show or hide the CPU Meter when the Resources utility is displayed
Right-click the Resources utility and check or uncheck Show CPU.

To show the CPU Meter when the Resources utility is hidden
1. Click  to open the Customize dialog box.

2. Click Resources to display preferences for the Resources utility.
3. Check the box labeled Show the Resource Monitor.
4. Check the Show CPU Meter box.



About the Printers utility
{button ,AL(`PRINTER_PANEL')} See also

The Printers utility lists all the currently installed printers, fax drivers, plotters, and other output devices.
Each printer’s path appears below its icon. With ToolTips enabled, you can move your mouse pointer 
onto a printer icon to see the printer’s full name and description.
You can:

Print or fax a file by dragging it to the desired printer icon.
You can drag a file from the Explorer, My Computer, or Network Neighborhood.
Change the default printer.
Choose which print devices (printers, plotters, and fax machines) you want to appear in the 

Printers utility. 
Specify the order in which print devices appear in the Printers utility.
Specify the icons and descriptions for each printer.

For information on using the Printers utility, click See Also, or click >> to browse through the topics.



Showing and hiding the Printers utility
{button ,AL(`PRINTER_PANEL')} See also

To show or hide the Printers utility
1. Click  to open the Customize dialog box.

2. Click Printers to display preferences for the Printers utility.
3. Check or uncheck Show Printers.



Printing or faxing a file
{button ,AL(`PRINTER_PANEL')} See also

To print or fax a file
1. Select a file to print in the Explorer, My Computer, or Network Neighborhood.
2. Drag the file to the default printer or fax icon on the Printers utility. 
If the file was created in a program that has printing options, such as specifying a page range to print, 
the program opens and the print dialog box is displayed. If it was created in a program that does not 
have printing options (such as Windows Notepad), the program is loaded and prints the file 
automatically.



Specifying the default printer
{button ,AL(`PRINTER_PANEL_CONFIGURING')} See also

The default printer is identified by a green light on its icon.

To specify the default printer
1. Scroll the Printers utility until the printer you want is visible.
2. Click the light on the icon of the printer you want as the default.



Installing a new printer
{button ,AL(`PRINTER_PANEL_CONFIGURING')} See also

The Printers utility displays all your installed printers.

To install a new printer
1. Display the Windows Control Panel.
2. Double-click Printers.
3. Double-click Add Printer, and follow the instructions.



Setting up a printer
{button ,AL(`PRINTER_PANEL_CONFIGURING')} See also

To set up a printer, do either of the following:
Click the printer in the Printers utility.
Right-click the Printers utility and choose Customize from the shortcut menu. Click Settings, and 

then click the Set Up button.
Change the settings as desired.
For details, see the Settings page.



Snapping the Printers utility on and off
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also

You can snap off the Printers utility and display it as a floating palette, or snap it on so it is attached to 
the Control Center. 
To snap on or snap off the Printers utility, either:

Click 

Right-click the Printers utility and choose Position from the shortcut menu.    Choose Snapped On 
or Floating from the submenu.



Rearranging printers on the Printers utility
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also

To rearrange the printers, do the following:
Right-click the Printers utility and click Customize on the shortcut menu. Click Settings and drag a

printer up or down in the list to change its position. 



Resizing the Printers utility
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also

If the Printers utility is not wide enough to display all printers, it includes scroll arrows.

To change the size of the Printers utility
1. Hold down the Shift key and move the pointer to the edge of the Printers utility.

The pointer changes to the resize cursor.
2. Drag the border to resize the utility.



Changing the description of the printer
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also

The description of the printer appears above the icon and in the ToolTips help.

To change the printer's description
1. Click  to open the Customize dialog box.

2. Double-click Printers in the Plug-Ins list, and then click Settings.
3. Click the Settings tab.
4. Select the printer that you want to change.
5. In the Printer Settings section, type a new description in the box.



Changing the printer icon
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also

An icon identifies each printer on the Printers utility.

To change the printer icon
1. Right-click the Printers utility and click Customize on the shortcut menu.
2. Click Settings.
3. Select the printer, and then click Change Icon.
5. Select an icon from the list and click OK.



Displaying or hiding the paper orientation
{button ,AL(`PRINTER_PANEL_APPEARANCE')} See also

An icon optionally identifies the paper orientation of each printer on the Printers utility.

To display or hide the paper orientation
1. Click  to open the Customize dialog box.

2. Double-click Printers in the Plug-Ins list, and then click Settings.
3. Click the Position tab.
4. In the Options section, check or uncheck Show paper orientation in printer icons.



About Virtual Screens
{button ,AL(`EXT_SCREENS')} See also

Using the Virtual Screens is like connecting your computer to several side-by-side monitors. Each 
Virtual Screen represents a full-screen view. You can open programs on the Virtual Screens, and then 
switch back and forth among them to work with the different programs. For example, suppose you 
want to work with Sidekick, Netscape Navigator, and Paradox. Rather than piling these programs up 
on the same screen, open Sidekick on the first Virtual Screen, Netscape on the second, and Paradox 
on the third.
In addition, you can launch multiple instances of your browser. Then you can view one site while the 
browser in another Virtual Screen is connecting to another site.    You can have up to nine Virtual 
Screens, and you can display them in compact, medium size, or full size mode.
Icons on the Virtual Screens let you tile and cascade the windows within the current Virtual Screen.    
You can tile open windows vertically or horizontally, or cascade open windows.



Switching between Virtual Screens
{button ,AL(`EXT_SCREENS')} See also

To switch from one Virtual Screen to another
Do one of the following:

Click the screen selector, which is the box at the bottom of the Virtual Screen. (If the Virtual 
Screens are displayed in Compact form, click the mini icon that represents the screen you want to 
activate.) Starfish Internet Utilities remains on top.

Double-click a Virtual Screen. If you double-click the screen background, Starfish Internet Utilities
remains on top. If you double-click a program's mini window, the program comes to the top.

Press a hot key. The program comes to the top, if a program is open in that screen.



Assigning hot keys to Virtual Screens
{button ,AL(`EXT_SCREENS')} See also

By assigning hot keys to your Virtual Screens, you can use the keyboard to switch from one screen to 
another.

To assign hot keys to Virtual Screens
1. Click  to open the Customize dialog box.

2. Double-click Virtual Screens.
3. Click Settings, and then click the tab for the Hot Keys page.
4. Click in the text box and enter a key sequence.

To clear an existing hot key sequence, click in the text box and press Del or Backspace.
In Starfish Internet Utilities' horizontal orientation, the numerical sequence of screens in the Customize
dialog box corresponds to the left-to-right order of the screens on Starfish Internet Utilities. In the 
vertical orientation, the numerical sequence corresponds to the top-to-bottom order on Internet Starfish
Internet Utilities.



Showing and hiding the Virtual Screens
{button ,AL(`EXT_SCREENS')} See also

To show or hide the Virtual Screens
1. Click  to open the Customize dialog box.

2. Click Virtual Screens in the Plug-Ins list.
3. Check or uncheck the Show box on the Virtual Screens page.



Specifying the display size for Virtual Screens
{button ,AL(`EXT_SCREENS_APPEARANCE')} See also

You can display the Virtual Screens in full, medium, or compact size.    Select smaller sizes to add 
more screens; choose full size to move programs within the Virtual Screens more easily. The Virtual 
Screens are numbered when they are in compact mode.

To specify the display size for Virtual Screens
1. Click  to open the Customize dialog box.

2. Double-click Virtual Screens in the Plug-Ins list, and then click Settings in the list.
3. Click the Screens tab.
4. Choose one of the following:

Full Size displays the screens in fully extended mode.
Medium Size allows you to display more screens.
Compact Size displays small, numbered screens.



Specifying the number of Virtual Screens
{button ,AL(`EXT_SCREENS_APPEARANCE')} See also

To specify the number of screens for the Virtual Screens
1. Click  to open the Customize dialog box.

2. Double-click Virtual Screens in the Plug-Ins list, and then click Settings.
3. Click the Screens tab.
4. Click a number in the Number of Screens section.

If you decrease the number of Virtual Screens, any applications in the removed screens are moved 
into the remaining screens.



Specifying the background for Virtual Screens
{button ,AL(`EXT_SCREENS_APPEARANCE')} See also

You can choose a predefined background for the Virtual Screens, or you can specify your own bitmap. 
In addition, you can add a monitor facade (resembling a border) around the screens.

To choose the background and add a facade
1. Click  to open the Customize dialog box.

2. Double-click Virtual Screens in the Plug-Ins List, and then click Settings.
3. Click the Background tab.
4. Check:

Predefined Background to select from the drop-down list of backgrounds provided with Starfish 
Internet Utilities.

Windows Desktop Background to use the wallpaper currently specified in your Windows 95 
Control Panel.

Specified Bitmap to specify a different .bmp file.    Enter the name of the file in the text box, or 
click Browse to locate the file.

5. Check Show Monitor Facades to add monitor facades around the screens.



About sticky apps
{button ,AL(`EXT_SCREENS_STICKY')} See also

When you're working with Virtual Screens, you'll want some programs to be assigned to a single 
screen. But you might want others such as Sidekick or your e-mail program

accessible from every Virtual Screen. You do this by designating these applications as sticky apps.



Creating a sticky app
{button ,AL(`EXT_SCREENS_STICKY')} See also

You can designate any running program as a sticky app.

To create a sticky app
1. Launch the program you want to designate as a sticky app.
2. Click  to open the Customize dialog box.

3. Double-click Virtual Screens in the Plug-Ins list.
4. Click Sticky Apps.
5. Click Add.

The Add Sticky App dialog box appears.
6. Select a program from the list.    



Removing a sticky app
{button ,AL(`EXT_SCREENS_STICKY')} See also

Once you designate a program as a sticky app, you can remove it at any time.

To remove a sticky app
1. Click  to open the Customize dialog box.

2. Double-click Virtual Screens in the Plug-Ins list.
3. Click Sticky Apps.
4. Select the sticky app you want to delete.
5. Click Remove.



About layouts
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

A layout is an arrangement of open programs in the Virtual Screens. You might find, for example, that 
different arrangements are best suited to different tasks.
You can create and save layouts for each of your projects or tasks. When you start working on a 
project, load its layout. The programs you need automatically open into the designated Virtual 
Screens.
The Layout menu contains the commands to save, load, and manage layouts.

Layouts and the Windows StartUp group
Layouts are one way to load programs automatically; the Windows StartUp group is another. Be sure 
your layouts don't load programs that are already loaded by the StartUp group. For maximum flexibility,
put Starfish Internet Utilities in your Windows StartUp group, and use the Virtual Screens layouts to 
load other applications as needed.

Layouts and setups
Layouts are different from setups:

A layout is the arrangement of program windows in the Virtual Screens.
A setup is the arrangement of items (such as QuickMarks, Virtual Screens, and Printers) on 

Starfish Internet Utilities.
Layouts and setups are sometimes related. For example, a layout that uses five Virtual Screens 
requires a setup with five screens. (If the current setup has only three screens, Starfish Internet 
Utilities "doubles up" the programs from the extra screens to fit into three.)
If you create a complex layout that requires a special setup, save the setup in the Customize dialog 
box. When you want to work with the layout, first open the setup in Customize, and then open the 
layout.



Creating a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To create a layout
1. Arrange the programs on the Virtual Screens the way you want them to appear when the layout 

appears.
2. Click  to display the Layout menu.

3. Choose Save Layout from the Layout menu.
The Save Layout dialog box appears.

4. Enter a name for the layout. If you accept the default name, "Default", the layout is named "Default".
5. Click OK.
Starfish Internet Utilities creates the layout and adds its name to the Layout menu.



Loading a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

Once you have created a layout by saving it, you can launch all its associated applications quickly by 
loading that layout.

To load a layout
1. Click  to display the Layout menu.

The Layout menu lists your saved layouts as well as a sample layout.
2. Click the layout you want to load, or click Load Sample Layout.

Starfish Internet Utilities launches all programs associated with the layout.
Keep the following in mind when loading layouts:

If a program is already open when you load a layout that uses the same program, but is in a 
different Virtual Screen or location within the Virtual Screen, the program is not repositioned.

Loading a layout doesn't unload or close any programs that are already open. Thus, if you've 
already opened some programs when you load a layout, you'll get the programs in the layout plus the 
open programs. For that reason, you might want to close some or all programs before loading a layout.



Loading a layout on startup
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To create a layout that automatically loads when you start Starfish Internet Utilities
1. Arrange the programs on the Virtual Screens the way you want them to appear when the layout 

appears.
2. Click  to display the Layout menu.

3. Choose Save Layout from the Layout menu.
The Save Layout dialog box appears.

4. Enter a name for the layout.
5. Check Load Layout on Startup.
6. Choose OK.
Starfish Internet Utilities creates the layout and adds its name to the Layout menu. When you start 
Starfish Internet Utilities, this layout is automatically loaded.
Although you can create more than one startup layout, you'll probably find that one is enough.    If you 
do create several startup layouts and want to change to a different one, use the Manage Layouts 
dialog box.

To disable the automatic loading of a startup layout
To start Starfish Internet Utilities without loading the layout, hold down the Shift key when you double-
click the Starfish Internet Utilities icon. Starfish Internet Utilities will not launch the startup layout.



Removing a program from a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To remove a program from a layout
1. Click  to display the Layout menu.

2. Choose Manage Layouts from the Layout menu.
The Manage Layouts dialog box appears.

3. In the Layout list, select a layout.
4. In the Applications list, select the program to delete.
5. Choose Delete.

Starfish Internet Utilities removes the program from the list.
6. Choose Save Changes.
You can also remove a program using the Save Layout dialog box.
Caution: The Delete Layout button deletes the entire layout. Don't confuse it with the Delete button, 

which removes a program from the layout.



Changing a program's layout information
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To change a program's information in a layout
1. Click  to display the Layout menu.

2. Choose Manage Layouts from the Layout menu.
The Manage Layouts dialog box appears.

3. In the Layout list, select a layout.
4. In the Applications list, select the program to change.
5. Choose Edit.

The Edit Layout dialog box appears.
6. Enter changes to the program's information.
7. Choose OK.
8. In the Manage Layouts dialog box, choose Save Changes.
You can also edit a program using the Save Layout dialog box.



Renaming a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To change a layout's name,
1. Click  to display the Layout menu.

2. Choose Manage Layouts from the Layout menu.
The Manage Layouts dialog box appears.

3. In the Layout list, select a layout.
4. Choose Rename.

The Rename Layout dialog box appears.
5. Specify a new name for the layout.
6. Choose OK.
7. In the Manage Layouts dialog box, choose Save Changes.



Deleting a layout
{button ,AL(`EXT_SCREENS_LAYOUT')} See also

To delete a layout
1. Click  to display the Layout menu.

2. Choose Manage Layouts from the Layout menu.
The Manage Layouts dialog box appears.

3. In the Layout list, select the layout to delete.
4. Choose Delete.
5. When Starfish Internet Utilities asks you to confirm the deletion, click Yes.
6. In the Manage Layouts dialog box, choose Save Changes.



About QuickRun
{button ,AL(`DASH_RUN')} See also

QuickRun takes the place of both a DOS prompt and the Start Menu Run command. You can enter 
DOS commands copy files, view directories, and manage programs.

The results window
The results window appears in the lower part of the QuickRun window. The results window displays a 
command prompt and the results of your DOS commands. You can also run commands that appear in 
the results window.



DOS commands supported by QuickRun
{button ,AL(`DASH_RUN')} See also

The result of supported DOS commands appear in the QuickRun results window. Most commands that
are not supported are passed on to DOS, where they are executed in a new DOS window. This DOS 
window remains open until you manually close it.
The following list shows you all the commands you can use at the QuickRun command prompt. To 
view an explanation of a specific command and the command syntax, click the command.
attrib
call
cd (chdir)
cls
copy
date
del (erase)
dir
echo
edit
exit
find
for
goto
help
if
label
md(mkdir)
path
pause
print
prompt
rd (rmdir) 
rem
ren (rename)
set
shift
sort
time
type
ver
vol
xcopy
The QuickRun dialog box does not support the Append, Choice, Defrag, DOSkey, Fastopen, Graphics,



Join, Loadhigh, More, or Share commands.



Starting QuickRun
{button ,AL(`DASH_RUN')} See also

To start QuickRun
Click the  button. 



Entering DOS commands in QuickRun
{button ,AL(`DASH_RUN')} See also

Use the Command Line box or the results window to enter DOS commands.

To enter DOS commands in the Command Line box
Open Quick Run by clicking the  button.

Then do any of the following:
Type the command in the Command Line box, and then click Run.
Use the Browse button to place the command in the Command Line box, and then click Run.
Click the arrow in the Command Line box to display the history list. If the command is displayed, 

choose it and then click Run.

To enter DOS commands in the results window
Open Quick Run by clicking the  button.

Then do any of the following:
Type the command at the DOS prompt in the results window, and then press Enter.
If the results window contains a DIR listing that displays the name of the command, double-click 

the command or drag it to a Virtual Screen.



About the Taskbar
{button ,AL(`TASKBAR')} See also

The Starfish Internet Utilities Taskbar provides features not available with the Windows 95 taskbar:
In addition to docking it at any side of the screen, you can have the Taskbar "float" anywhere 

within the window.
You can right-click the Taskbar and choose Task List to open the Task Manager and get 

information about any open application.
The Taskbar can display labeled or unlabeled icons.

The Taskbar displays all running programs as buttons. Clicking a program's button switches to that 
program. 
When you start a program, Starfish Internet Utilities automatically adds it to the Taskbar. When you 
close a program, Internet Utilities removes it from the Taskbar.
For information on using the Taskbar, click See Also, or click >> to browse through the topics.



Showing and hiding the Taskbar
{button ,AL(`TASKBAR')} See also

To show or hide the Taskbar
1. Click  to open the Customize dialog box.

2. Click Taskbar to display preferences for the Taskbar.
3. Check or uncheck the Show box.



Snapping the Taskbar on and off
{button ,AL(`TASKBAR')} See also

You can snap off the Taskbar and display it as a floating palette. You use the Taskbar in the same way 
whether it is on the Control Center or snapped off.

To snap the Taskbar on or off 
Do either of the following:

Click 

Right-click the Taskbar and choose Position: Snapped On or Floating, Top Edge, Bottom Edge, 
Left Edge, or Right Edge.



Positioning the Taskbar on your screen
{button ,AL(`TASKBAR')} See also

You can dock the Taskbar to any edge of your screen, or have it float in your work space.

To position the snapped-off Taskbar
Do any of the following:

Right-click the snapped-off Taskbar and click Position. Then choose Top Edge, Bottom Edge, Left
Edge, Right Edge, or Floating from the Position submenu. 

Right-click the Taskbar and then click Settings. On the Position page, click one of the Taskbar 
Position options.



Specifying icons and labels for the Taskbar
{button ,AL(`TASKBAR')} See also

You can specify whether the programs on the Taskbar have large icons or small icons. 

To specify icons and labels for the Taskbar
Right-click the Taskbar and click Customize on the shortcut menu. Click Settings and select the 

desired label and icon style.



Viewing task information
{button ,AL(`TASKBAR')} See also

To view task information about open applications
1. Right-click the snapped-off Taskbar.
2. Choose Task List to open the Task Manager.
3. In the Task List, select an application.
4. Click Task Info.
The Task Information box opens, showing the name and path of the executable file, as well as Usage, 
Priority, and Threads.
You can also view information about running programs by right-clicking the Resources utility and 
choosing Details from the shortcut menu.



configuration
The appearance and behavior of Starfish Internet Utilities; all your preferences and settings. You can 
customize the configuration of every utility in Starfish Internet Utilities, as well as the Internet Utilities 
Control Center.
You can create and save as many Starfish Internet Utilities configurations as you want.



QuickRun
A dialog box containing both a command line and a DOS command window from which you can 
execute DOS commands to search directories, copy files, and launch programs.

To use QuickRun, click .



Virtual Screen
One of several representations of full-screen views. Using the Virtual Screens is like connecting your 
computer to several side-by-side monitors. You can open programs on the Virtual Screens and then 
switch back and forth among them to work with the different programs.



GDI resources
Graphic Device Interface resources; one of the two key components of Windows system resources. 
Windows uses GDI memory for graphics operations, such as drawing bitmaps, lines, and fill patterns. 
Windows reserves 64K of memory for GDI resources.
See also Windows system resources, user resources



hot key sequence
A key sequence that activates a program.
When defining a hot key sequence, you can use several types of keys:

Function keys F1-F9 and F11-F24 (if you have them)
Modifying keys (such as Alt, Shift, and Ctrl)
ASCII keys
Arrow keys

Choose a sequence that is unique and easy to remember.



layout
The arrangement of program windows in the Virtual Screens. A layout is like a freeze-frame picture of 
Starfish Internet Utilities at a specific moment. You can save layouts, which then appear on the Layout 
menu.
To work with layouts, click  to display the Layout menu.



shell
The program that opens when you run Windows; closing the shell closes Windows.



snooze interval
The number of minutes after which the alarm reappears when you click the Snooze button in an alarm 
message.



sticky app
A program that is displayed in every Virtual Screen. When you designate programs as sticky apps, 
they are always displayed, regardless of which Virtual Screen you are viewing.



total memory
The total amount of memory available on your computer, including Windows system memory and other
memory not allocated to Windows.



user resources
One of the two key components of Windows system resources. Windows uses user memory for non-
graphics features, such as text, menus, and window frames. Windows reserves 64K of memory for 
user resources.
See also Windows system resources, GDI resources.



wildcard
A wildcard is a character such as an asterisk that represents any other character(s) that appears in the
same place.    For example, *.doc means all files that have the extension .doc, which might include 
Mouse.doc, Turtle.doc, and Deer.doc.    You can also use wildcards to include every file in a directory:   
children\games\*.* specifies all files (with any name and any extension) in the children\games 
directory.    This might include Hopscotch.exe, Jumprope.txt, and Hideandgoseek.doc. 



Windows shell
The program that opens when you run Windows; closing the shell closes Windows.



Windows system resources
The portion of memory reserved by Windows for its own operation. The two key components of system
resources GDI resources and user resources

each reserve 64K of memory.
Every Windows application you open uses up some of the GDI resources and user resources. If you have
too many applications open, the available level of system resources becomes too low to launch any new 
Windows applications. If you are unable to launch a new application, or the Resources utility indicates 
that your system resources are too low for the application you want to launch, you can increase the level 
of available system resources by closing one or more of your currently running applications.

See also user resources, GDI resources



working directory
When you want to work with data files in a different directory than the program you use to create those 
files, you specify a Working Directory in the Customize dialog box. When you launch the program, the 
current directory will be the working directory. Here's an example: Your word processing program, 
Word for Windows, is in a directory named WINWORD, but you've specified a working directory 
named MEMOS. When you run Word and use the Open command, you'll see MEMOS displayed as 
the working directory in the Open File dialog box.



archive
A group of files typically is “zipped” (compressed) into a single file, which is referred to as an archive.    
Archives are useful for saving hard disk space and for quickly transferring files over a network or 
modem.    The archive contains copies of the zipped files;    the original files are left intact.
See also zip, unzip.



zip
The act of compressing groups of files into an archive often is referred to as “zipping.”    The archive 
contains copies of the zipped files; the original files are left intact.    For example, suppose you zip 
Cat.doc, Dog.doc, and Owl.doc, and create Animals.zip.    The new archive, Animals.zip, contains 
compressed copies of Cat.doc, Dog.doc, and Owl.doc.
See also archive, unzip.



unzip
The act of extracting compressed files from an archive is often referred to as “unzipping”    The 
unzipping process creates exact copies of the original files from the compressed versions stored in an 
archive.    For example, unzipping a file named Animals.zip could result in copies of Cat.doc, Dog.doc, 
and Owl.doc, leaving Animals.zip unchanged by the extraction process.
See also archive, zip. 



Associate QuickZip with the .ZIP Extension
If you check this box,    you can:

right-click on a file and select QuickZip from the shortcut menu to open the Zip dialog box with 
that file added..

right-click a .zip file and select Open or Quick Open from the shortcut menu to open the Zip 
Viewer window with that file’s contents displayed. You can also double-click a .zip file to use the Zip 
Viewer window. Select Quick Extract from the shortcut menu if you do not want to view the contents of the
file and want to extract its contents immediately.



Zip Sub-Directories
Check this box if you want the contents of any directories below the directory or file path that you enter
on the Zip Files page to be zipped as well.



Uppercase File Names
Check this box if you want to store file names in capital letters.



Use DOS (8.3) File Names
Check this box for DOS and Windows 3.1 compatibility, including eight-character names and three-
character extensions.    Note the following limitation:    if the first eight non-space characters of two or 
more files are identical and have the same extensions, the zipping process will not distinguish between
them.    This means that only the last file is included in the .zip file.



Default Zip Mode
Check:

Add Files to add files to an existing .zip file or to create a new .zip file.
Update Files if you want to update the files in an existing .zip file. This choice replaces older files 

with new versions, and, if there are any new files that do not exist in the .zip file, adds the new files.
Freshen Files to replace the existing files with any more recent versions.

See also archive.



Compression
Refers to the special format that minimizes the disk storage space required.    Use low or no 
compression to increase the speed of the zipping process and save time.    Use a higher compression 
when you want to create a small .zip file, which saves disk space and reduces transmission time, if the
.zip file is saved to a compressed drive.
See also archive.





Overwrite Existing Files
Check this box if you want files that are extracted from the .zip file to replace files with the same name 
in the target directory.



Create Directories As Needed
Check this box if you want any directories that are included in your archive automatically created for 
you.



Path for Temporary Files
This is the location where temporary files are stored during a zip or unzip operation.    Enter a directory 
or click Browse if you want to change the location of temporary files created by QuickZip.



Self-Extracting Files (exe)
A self-extracting file (.exe) is a compressed file similar to a .zip file, but you can unzip a self-extracting 
file just by double-clicking it.    A dialog box opens first allowing you to specify into which directory you 
want to extract the file. However, if you use QuickZip to open a self-extracting file, you can see the 
contents of your .exe file and decide which files to uncompress.



Store Paths
Check this box to include the file paths in your .zip file.





About button
{button ,AL(`BUTTONS')} See also

The About button  shows information about Starfish Internet Utilities, including the product number, 
product version number, and copyright information.



QuickRun button
{button ,AL(`BUTTONS')} See also

The QuickRun button  displays the QuickRun dialog box, which performs DOS commands and 
launches programs.



Customize button
{button ,AL(`BUTTONS')} See also

The Customize button  opens the Customize dialog box, which customizes and sets the preferences 
for Starfish Internet Utilities.

For example, you can use the Customize dialog box to:
Specify the fonts and colors to be used on Starfish Internet Utilities
Set hot keys to toggle Starfish Internet Utilities in front of or behind other windows
Create and save specific configurations of Starfish Internet Utilities and load them as needed



Help menu
{button ,AL(`BUTTONS')} See also

Use the Help button  to find the help you need. Click Help and then choose
Contents to see the Help Table of Contents.
What is This? to display the question mark cursor. Place the question mark over any item on 

Starfish Internet Utilities and click to see help for that specific item.
About Starfish Internet Utilities to see information about this version of Starfish Internet Utilities.



Maximize button
{button ,AL(`BUTTONS')} See also

The Maximize button  extends Starfish Internet Utilities horizontally to its full width.
When you click the Maximize button, any expandable utilities (such as QuickMarks) grow and use more 
space in Starfish Internet Utilities. Expandable utilities display scroll arrows to indicate items that are not 
currently shown. If none of the currently displaying utilities are expandable, Starfish Internet Utilities does 
not change its size.
Use the Restore button  to return Starfish Internet Utilities to its previous width.



Minimize button
{button ,AL(`BUTTONS')} See also

The Minimize button  minimizes Starfish Internet Utilities into the Windows 95 taskbar.
Click the Starfish Internet Utilities button in the Taskbar to restore Starfish Internet Utilities.



Restore button
{button ,AL(`BUTTONS')} See also

The Restore button  restores the previous size of Starfish Internet Utilities, after you have maximized
it with the Maximize button.



Close button
{button ,AL(`BUTTONS')} See also

The Close button  closes Starfish Internet Utilities.



Snap-off controls
{button ,AL(`BUTTONS')} See also

The snap-off controls are buttons that snap utilities on or off the Starfish Internet Utilities Control 
Center. A triangle in the button indicates the current state of each utility:

A triangle in the upper-right corner of the button indicates that it is a snapped-off utility.
A triangle in the lower-left corner of the button indicates that it is a snapped-on utility.



Layout button
{button ,AL(`BUTTONS')} See also

The Layout button  displays the Layout menu, which names, saves, and loads custom layouts or edits
existing layouts. When you save a layout, Starfish Internet Utilities saves all the programs currently 
running, as well as their size and position on the Virtual Screens.



System menu

The System menu  includes standard Windows System menu commands for working with the 
window, as well as Starfish Internet Utilities commands.



Title bar
The title bar displays the Starfish Internet Utilities title, and it can also show information about your 
system resources. Click and drag the title bar to move the Internet Utilities Control Center wherever 
you want on your screen.



Sizing bar
The sizing bar surrounds the Control Center and is used to resize it.
The pointer becomes a two-headed arrow when you position it over the sizing bar. Drag to change the 
width or height of Starfish Internet Utilities.
Resizing Starfish Internet Utilities may prevent some utilities from displaying all their items. When this 
happens, utilities on the left or on the top have priority over utilities on the right or on the bottom.
For example, if QuickMarks is to the left of the Printers utility, more QuickMarks buttons than printers 
are visible. You can use the scroll arrows to see the other printers, or you can resize the Printers utility 
by holding down the Shift key and dragging the utility’s borders. 



Call Log button
{button ,AL(`BUTTONS')} See also

The Call Log button opens the Call Log window, which provides a registry of all your calls, including 
the duration of each call and the service provider. 
You can:

View detailed information about each online connection.
Track how many online hours you have accumulated.
Print copies of your logs.



Zip/Unzip buttons
{button ,AL(`BUTTONS')} See also

Use the Zip and Unzip buttons on the QuickZip utility to compress and uncompress files quickly and 
easily. You can zip and unzip .zip files and self-extracting files (.exe).



Zip button (QuickZip)
{button ,AL(`ZIP')} See also

Use the Zip button to compress files quickly and easily. You can create .zip files and self-extracting 
files (.exe).
Zipping does not change the original files. It compresses them into a single .zip file, called an archive. 
The smaller file saves disk space and is faster to transmit.



Unzip button (QuickZip)
{button ,AL(`ZIP')} See also

Use the Unzip button to uncompress archived (.zip) files quickly and easily. Unzipping leaves the 
archive file intact, while extracting copies of the original files.



Unzip Selected button (QuickZip)
{button ,AL(`ZIP')} See also

The Unzip Selected button in the Zip Viewer window lets you select only the files you want to extract. 



Up One Level button (QuickZip)
{button ,AL(`ZIP')} See also

Up One Level moves you up to the next higher folder in an archive that contains folders.    It is dimmed 
until you double-click a folder to see its contents; then you can click this button to return to the higher 
level folder.



Unzip All button (QuickZip)
{button ,AL(`ZIP')} See also

The Unzip All button in the Zip Viewer window lets you extract all files in an archive.



View Item button (QuickZip)
{button ,AL(`ZIP')} See also

Select a file in the Zip Viewer window and then click the View Item button to view the file.



Launch Item button (QuickZip)
{button ,AL(`ZIP')} See also

Select a file in the Zip Viewer window and then click the Launch Item button to launch the program.
If it is an executable file, Launch Item launches the program.
If the file is a document, Launch Item opens it in the associated program.



Add Item button (QuickZip)
{button ,AL(`ZIP')} See also

The Add Item button lets you add a new file to an archive.



Remove Item button (QuickZip)
{button ,AL(`ZIP')} See also

Select a file in the Zip Viewer window and then click Remove Item to remove it from the archived (.zip) 
file.



Large Icons button (QuickZip)
{button ,AL(`ZIP')} See also

Click the Large Icons button to see an array of the zipped files with large icons and file names. Long 
files names are truncated, with ellipses (for example, kangaro…) to show they are incomplete.



Small Icons button (QuickZip)
{button ,AL(`ZIP')} See also

Click the Small Icons button to see a multi-column list of the zipped files with small icons and full file 
names.



List button (QuickZip)
{button ,AL(`ZIP')} See also

Click the List button to see all the zipped files in one column with small icons and full file names.



Details button (QuickZip)
{button ,AL(`ZIP')} See also

Click the Details button to see a list of the zipped files with file details.
This view shows:

small icons and file names
file types
original and compressed file sizes
date and time the files were last modified
file attributes



Help button (QuickZip)
{button ,AL(`ZIP')} See also

Click the Help button to see online help for working in the Zip Viewer window.



What’s New button
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_BUTTONS')} See also

Click the What’s New button to open the What’s New    window. Here you can see a list of items that 
have been tagged by QuickMarks as changed, such as an updated Web site. For details, see What’s 
New.



Manage QuickMarks button
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_BUTTONS')} See also

Click the Manage QuickMarks button to open the Manage QuickMarks menu, which lets you perform 
tasks ranging from adding new tabs to importing new QuickMarks.
For details, see About the Manage QuickMarks button.



Find QuickMark button (QuickMarks)
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_BUTTONS')} See also

Click the Find QuickMark button to locate items in the QuickMarks utility by searching for titles or 
context strings.
For details, see About the Find QuickMark window.



Reminder button
{button ,AL(`CLOCK_CALENDAR')} See also

Click the Reminder button  to open the InternetClock Reminder dialog box, where you can schedule
a new reminder.

To see a list of all reminders, alarms, and computer tasks you’ve already set, right-click the InternetClock 
utility and choose Customize.    Then click Events in the Plug-Ins list.



Time Synchronizer button
{button ,AL(`CLOCK_CALENDAR')} See also

Click the Time Synchronizer button to synchronize your computer’s system clock with an Internet time 
server.
To choose a time server and a connection method, right-click the Time Synchronizer icon in your 
Windows 95 system tray and use the shortcut menu.



SlimView button
{button ,AL(`BUTTONS')} See also

Click the SlimView button when the Control Center is docked to reduce the space needed by the 
Control Center. For details, see Reducing the space needed by the Control Center.



Clocks page (InternetClock)
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_APPEARANCE')} See also

Lets you add and remove clocks from the InternetClock.
To display the Clocks page, click the Customize button and double-click InternetClock in the Plug-Ins 
list.    Then select Settings from the Plug-Ins list and click the Clocks tab.

The Clocks page 

Clocks
Shows the clocks currently displayed on the InternetClock.

To add another clock to the utility, click Add. You can have up to four clocks.
To remove a clock from the InternetClock, select it in the Clocks list and then click Remove.

Time
Select a clock to change its time zone and, optionally, enter a caption for it:

To change the time zone, choose a new time zone from the drop-down list.
To change the caption for the clock, type a new caption in the Caption box.

To set your system date and time, click Set Date/Time. The Windows Date/Time Properties dialog box 
opens.



Appearance page (InternetClock)
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_APPEARANCE')} See also

Customizes the appearance of each clock on the InternetClock.
To display the Appearance page, click the Customize button and double-click InternetClock. Then 
select Settings from the list and click the Appearance tab.

The Appearance page

Clocks
Lists the clocks currently displayed on the InternetClock. Select a clock in this list to change its 
appearance.

Clock Face
Click either analog or digital, and then choose the clock face from the drop-down list. The sample clock
changes to show what your selection will look like.

Analog shows the minute and hour hands pointing to numbers on the clock face.
Digital represents the time as a number.

If you choose Analog, you can check the Show Second Hand box to display a second hand on that 
clock face.
Note: The second hand might interfere with some communication programs. If your communication 

program is experiencing unnecessary time-outs, try hiding the second hand.



Synchronization page (InternetClock)
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_SYNCH')} See also

Lets you select the specific time server to be accessed for the Internet Time Synchronizer, and the 
time interval for automatic time synchronization.
To display the Synchronization page, click the Customize button and double-click InternetClock. Then 
select Settings from the list and click the Synchronization tab.

The Synchronization page

Time Server Synchronization
Check the Use Time Server Synchronization box to enable the Internet Time Synchronizer.

Click Synchronize Now to correct your system time immediately.
Click Set Up Synchronization to select a time server and choose a connection method.



Events page (InternetClock)
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_ALARM')} See also

Lets you set, change, remove, and temporarily disable reminders, alarms, and tasks.
To display the Events page, click the Customize button and double-click InternetClock. Then select 
Events from the list and click the Events tab.

The Events page

Schedule
Lists the currently scheduled reminders, alarms, and computer tasks. 

To add to or modify this list,
Click Add Reminder to display the InternetClock Reminder dialog box.
Click Add Alarm to display the InternetClock Alarm dialog box.
Click Add Task to display the InternetClock Task dialog box. (The term “task” refers to scheduling 

an application to run automatically on your computer at a pre-set time.)
Select an event in the list and click Modify to edit it.
Select an event in the list and click Remove to delete it.

Recurring Events
Check the Disable Recurring Events box to turn off all recurring reminders, alarms, and tasks 
temporarily.



InternetClock Reminder dialog box
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_ALARM')} See also

Lets you schedule new reminders or modify existing ones.
To display the InternetClock Reminder dialog box, do one of the following:

Click the Customize button and double-click InternetClock. Then select Events from the list and 
click the Events tab.    Click the Add Reminder button on that page.

Select an existing reminder on that page and click the Modify button.
Click the Reminder button 

 on the InternetClock.

The InternetClock Reminder page

Date
Choose a single date or schedule a repeating date.

Time
Choose the time and time zone for the reminder, or set a repeating time interval.

Reminder
Enter a reminder message (such as “Remember to feed the cats!”) in the box.



InternetClock Alarm dialog box
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_ALARM')} See also

Lets you set new alarms or modify existing ones.
To display the InternetClock Alarm dialog box, click the Customize button and double-click 
InternetClock in the Plug-Ins list.    Click Events, and click the Events tab.    Then click the Add Alarm 
button on that page, or select a listed clock and click Modify.

The InternetClock Alarm page

Date
Choose a single date or schedule a repeating date.

Time
Choose the time and time zone for the reminder, or set a repeating time interval.

Alarm

Select the sound you want for the alarm. To preview the sound, click the Play  button.



InternetClock Task dialog box
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_ALARM')} See also

Lets you schedule a program to start on a specific day or on repeating days, or set a program to start 
at a specific time associated with a specific time zone.
To display the InternetClock Task dialog box, click the Customize button and double-click InternetClock
in the Plug-Ins list.    Click Events, and click the Events tab.    Then click the Add Task button on that 
page, or select a listed Task and click Modify.

The InternetClock Task page

Date
Choose a single date or schedule a repeating date.

Time
Choose the time and time zone for the reminder, or set a repeating time interval.

Task
Enter the program’s name, working directory, and, optionally, command-line parameter for starting it.

Run Minimized
Click to run the program minimized.



Options page (InternetClock)
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_ALARM')} See also

Lets you choose sound and display options for reminders, and set the snooze interval.

To display the Options page, click the Customize button and double-click InternetClock.    Then select 
Events and click the Options tab.

The Options page

Options
Use the arrows to set the snooze interval, which is the number of minutes after which the reminder 
reappears when you click the Snooze button in a reminder message.
Select a reminder message preference:    

Click the pop-up messages option if you want to view the reminder messages in dialog boxes at 
the scheduled times.

Click the system tray icon option if you want to be able to read the reminder message at your 
convenience by clicking that icon.

Reminder Chime
Select a chime from the drop-down list.    It will play when a reminder message appears. To preview the

sound, click the Play  button.



Printers page
{button ,AL(`PRINTER_PANEL;PRINTER_PANEL_CONFIGURING')} See also

Choose whether to display the Printers utility on the Control Center.
To view the Printers page, click the Customize button and select Printers from the Plug-Ins list.

The Printers page
Check the Show box to display the Printers utility. Uncheck the Show box to hide it from view.

Default Printer
Shows the current default printer.



Settings page (Printers)
{button ,AL(`PRINTER_PANEL;PRINTER_PANEL_CONFIGURING')} See also

Lets you change the order of the printers, hide a printer, pick a different printer icon, and give each 
printer a unique description.

To display the Settings page, click the Customize button and double-click Printers in the Plug-Ins list. 
Select Settings from the Plug-Ins list and click the Settings tab.

The Settings page
The list in the Settings page shows the installed printers on your system.    To change the position of a 
printer icon on Starfish Internet Utilities, drag it to a new location.
Printer Settings
Select a printer from the list and enter a description for it.    The description you enter appears on the 
printer’s button and in its ToolTip.
Check the Show box to display the selected printer on the Control Center.

Set Up
Click Set Up to set up the selected printer.    (This is the same as choosing Printer Setup from the File 
menu in many Windows applications).

Change Icon
Click to select a new icon for the selected printer’s button.



Position page (Printers)
{button ,AL(`PRINTER_PANEL;PRINTER_PANEL_CONFIGURING')} See also

Lets you specify whether to show the paper orientation and choose whether to have the Printers utility 
snapped off or snapped onto the Control Center.

To display the Position page, click the Customize button and double-click Printers in the Plug-Ins list. 
Select Settings, and then click the Position tab.

The Position page
Position
Choose whether you prefer the Printers utility:

Snapped Onto the Control Center.
Snapped Off and Floating.

Options
Check Always in Front to have the snapped off Printers utility appear in front of other windows.
Check Show Paper Orientation in Printer Icons to display the orientation (portrait or landscape) 

with the printers’ icons on the Control Center.



Virtual Screens page
{button ,AL(`EXT_SCREENS;EXT_SCREENS_APPEARANCE')} See also

Lets you show or hide the Virtual Screens on the Control Center.
To view the Virtual Screens page, click the Customize button and select Virtual Screens in the Plug-Ins
list.
Check the box to display the Virtual Screens.



Screens page
{button ,AL(`EXT_SCREENS;EXT_SCREENS_APPEARANCE')} See also

Lets you choose the number of Virtual Screens to be displayed, and choose whether to display the 
screens in compact, medium, or full size format.    Depending on the size of the window and your 
monitor’s resolution, you can display up to nine Virtual Screens.

Select smaller sizes to add more screens; choose full size to move programs within the Virtual 
Screens more easily. 

To display the Screens page, click the Customize button and double-click Virtual Screens in the Plug-
Ins list.    Select Settings from the list, and then click the Screens tab.

The Screens page
Screen Size
Select from Full Size, Medium Size, and Compact Size.

Number of Screens
Select the number of Virtual Screens on Starfish Internet Utilities; your choices may be limited by the 
available space.



Background page
{button ,AL(`EXT_SCREENS;EXT_SCREENS_APPEARANCE')} See also

Lets you select a background for your Virtual Screens.

To display the Screens page, click the Customize button and double-click Virtual Screens in the Plug-
Ins list. Then select Settings from the list and click the Background tab.

The Background page

Background
Specifies a background to use for the Virtual Screens.

Predefined specifies that the Virtual Screens background is one of the default backgrounds 
provided with Starfish Internet Utilities.

Use the Windows Background specifies that the Virtual Screens background is the same as the 
current Windows background.

Use the Specified Bitmap lets you pick a .bmp file for the Virtual Screens background. Enter the 
name of the bitmap or click Browse to select a name and path.

Show Monitor Facades
Check the box to add borders around the Virtual Screens.



Hot Keys (Virtual Screens)
{button ,AL(`EXT_SCREENS')} See also

Lets you assign hot keys to your Virtual Screens, so you can switch between Virtual Screens without 
displaying the Control Center.    

To display the Hot Keys page, click the Customize button and double-click Virtual Screens in the Plug-
Ins list.    Then select Settings from the list and click the Hot Keys tab.

The Hot Keys page
Type a key combination directly into any text box.    Virtual Screens are listed by number. You can use 
certain keys in combination, such as Ctrl, Alt, and Shift.
Hot keys are attached to Virtual Screens, not to applications. The screens appear in order from left to 
right when the Control Center is horizontal, or top to bottom when it is vertical. You see these numbers 
when you display Virtual Screens in compact size.



Sticky Apps page
{button ,AL(`EXT_SCREENS;EXT_SCREENS_STICKY')} See also

Lets you create a sticky app for the Virtual Screens.

To display the Sticky Apps page, click the Customize button and double-click Virtual Screens in the 
Plug-Ins list.    Then select Sticky Apps from the list.

The Sticky Apps page

Add
Lets you make a running program a sticky app.

Remove
Removes the selected program from the list of sticky apps.



Taskbar page
{button ,AL(`TASKBAR;TASKBAR_APPEARANCE')} See also

Choose whether to show the Taskbar on the Control Center.
To view the Taskbar page, click the Customize button and select Taskbar from the Plug-Ins list. 
Check the Show box to display the Taskbar. 



Settings page (Taskbar)
{button ,AL(`TASKBAR;TASKBAR_APPEARANCE')} See also

Lets you specify the button style for the Taskbar.

To display the Settings page, click the Customize button and double-click Taskbar in the Plug-Ins list.    
Select Settings and click the Settings tab.

The Settings page

Button Style
Select a Taskbar button style from the choices.    Check Labeled if you want program names to appear 
with their icons; check Unlabeled if you want only the icons to be displayed.

Iconized Applications
Check the box to hide the icons of programs that are minimized.    They are still available in the 
Taskbar.    This option is available only if you are using certain versions of Windows 95 and Windows 
NT.



Position page (Taskbar)
{button ,AL(`TASKBAR;TASKBAR_APPEARANCE')} See also

Lets you specify the position of the Taskbar, including the option of docking it to the edge of your 
screen.

To display the Position page, click the Customize button and double-click Taskbar from the Plug-Ins 
list. Select Settings in the list, and then click the Position tab.

The Position page

Taskbar Position
Select the desired position of the Taskbar.    Click Snapped Off and Floating to make the Taskbar a 
floating palette.    Click one of the Docked options to attach the Taskbar to the top, bottom, left, or right 
side of the screen.

Options
Check Enable SlimView to reduce the size needed by the Taskbar.
Check Always in Front to keep the Taskbar in front of all other windows, even if another window is

active.



InternetMeter page
{button ,AL(`MONITOR')} See also

Lets you show or hide the InternetMeter.

To display the InternetMeter page, click the Customize button and select InternetMeter from the Plug-
Ins list.

Click the check box to display the InternetMeter.



Settings page (InternetMeter)
{button ,AL(`MONITOR')} See also

Lets you change your meter size and type of data displayed for the InternetMeter.

To display the Settings page for the InternetMeter, click the Customize button and double-click 
InternetMeter in the Plug-Ins list.    Select Settings from the list and click the Settings tab.

The Settings page

Size
Choose Full Size or Compact. Check Compact Size if you need to save space on Internet Utilities.

Connection Display
Choose whether to display connection information as modem lights or as a histogram.    The histogram
shows a graphical representation of online input and output progress.

Set Up Location
Opens the Windows Control Panel Dialing Properties dialog box, where you can change your location 
setup.

Set Up Modem
Opens the Windows Control Panel Modem Properties dialog box, where you can change your modem 
information.



Position page (InternetMeter)
{button ,AL(`MONITOR')} See also

Lets you change the position of the InternetMeter.

To display the Position page for the InternetMeter, click the Customize button and double-click 
InternetMeter in the Plug-Ins list.    Select Settings from the list and click the Position tab.

The Position page

Position
Choose whether you want the InternetMeter snapped off or snapped on.

Options
Check Always in Front to have the InternetMeter, when it is snapped off, always appear in front of 
other windows, even if another window is active.



Services page (InternetMeter)
{button ,AL(`MONITOR')} See also

In most cases, you will not need to modify the system’s information about your online service 
providers.    However, you may want to add or remove a service provider.    In addition, if the name of 
the service provider is too long to fit on the screen or in your logs, you can specify a shortened name.   
To make any of these changes, use the Services page.

To display the Services page for the InternetMeter, click the Customize button and double-click 
InternetMeter in the Plug-Ins list.    Select Services from the list and click the Services tab.

The Services page

Online Services
Lists the online services recognized by the InternetMeter.

Click Add to enter the name of a new service provider, and enter the name in the Service Name 
list (see below).

Click Remove to delete a selected service provider.

Service Name
Enter the name of a new service provider in the box;    if needed due to length, enter a shortened name
or alias for that service provider.

Disable Call Logging for This Service
Select the name of a service provider and check the box to turn off call logging for that provider.



Free Time page (InternetMeter)
{button ,AL(`MONITOR')} See also

If your online service provider limits your free time, use the Free Time page to track your hours and 
have the InternetMeter remind you when you have used up your free hours.

To display the Free Time page for the InternetMeter, click the Customize button and double-click 
InternetMeter in the Plug-Ins list.    Select Services from the list and click the Free Time tab.
Note: Online and Internet service providers vary in their policies concerning their billing practices, 

such as in their methods for rounding up the hours spent or billing in minimum time increments. 
They also may change their policies. InternetMeter does not account for all such variables. 
Although InternetMeter will reflect the actual time spent online, that time may not reflect your 
final bill from your service provider.

The Free Time page

Online Services
Displays a list of online services that the InternetMeter currently recognizes.    

Free Time
Select a service provider from the Online Services list and enter the time you have accumulated and 
the billing start date.    You can then view this page regularly to see instant updates of the number of 
remaining free hours. In addition, the InternetMeter displays a “Free Time” message in red when one-
half hour remains before the expiration time.



Identification page (InternetMeter)
{button ,AL(`MONITOR')} See also

With some applications, such as some versions of Hyperterm, the InternetMeter cannot determine the 
name of the provider you are using.    Instead, it will show you the name of the application (.exe) that 
has launched the call or connection.    In such cases, use the Identification page to identify the service 
provider by entering either the application name without a path or the phone number that you use to 
connect to that service provider.

To display the Identification page for the InternetMeter, click the Customize button and double-click 
InternetMeter in the Plug-Ins list.    Select Services from the list and click the Identification tab.

The Identification page

Online Services
Displays a list of online services that the InternetMeter currently recognizes. 

Identification
If needed because of an application you are using, enter its .exe.    Or, enter the phone number(s) that 
you use to connect to that provider.



QuickZip page
{button ,AL(`ZIP')} See also

Lets you display and hide QuickZip.    In addition, you can associate QuickZip with the .zip extension, 
which gives you the ability to zip or unzip a file from that file’s shortcut menu.

To display the QuickZip page, click the Customize button and select QuickZip from the Plug-Ins list.

The QuickZip page
Check the Show box to display QuickZip on the Control Center; uncheck it to hide QuickZip from view.
Associate QuickZip with the .zip Extension
If you check this box, you can:

right-click on a file and select QuickZip from the shortcut menu to open the Zip dialog box with 
that file added.

right-click a .zip file and select Open or Quick Open from the shortcut menu to open the Zip 
Viewer window with that file’s contents displayed. Select Quick Extract from the shortcut menu if you do 
not want to view the contents of the file and want to extract its contents immediately. You can also double-
click a .zip file to use the Zip Viewer window.

double-click an attached .zip file in MS Exchange to open it in the Zip Viewer window. In addition, 
you can double-click a .zip file on a Web page in Netscape Navigator or Microsoft Internet Explorer 
(version 2.0 or higher), and open that .zip file in the Zip Viewer window. If it is a large file, however, the 
downloading process before the Zip Viewer window opens with the .zip file displayed may be time-
consuming.

Note: If you already made an association with another zip program and check the Associate QuickZip 
box, a message box asks if you want QuickZip to be your default Zip program. Click OK to 
change to QuickZip.



Zip page
{button ,AL(`ZIP')} See also

Lets you modify the settings for zipping files with QuickZip.    After you change your preferences, your 
modified settings become the default.    This means that the next time you use QuickZip, the changes 
you made will appear in the Zip dialog box pages.

To display the Zip page, click the Customize button and double-click QuickZip in the Plug-Ins list.    
Select Settings from the list, and then click the Zip tab.

The Zip page
You can modify the following Zip preferences:

Zip Sub-Directories
Store Path Names
Use DOS (8.3) File Names
Uppercase File Names
Default Mode
Compression



Unzip page
{button ,AL(`ZIP')} See also

Lets you modify the settings for unzipping files with QuickZip. After you change your preferences, your 
modified settings become the default.    This means that the next time you use QuickZip, the changes 
you made will appear in the Zip dialog box pages.

To display the Unzip page, click the Customize button and double-click QuickZip in the Plug-Ins list.    
Select Settings from the list, and then click the Unzip tab.

The Unzip page
You can modify the following Unzip preferences:

Overwrite Existing Files
Create Directories as Needed
Path for Temporary Files



Files page (QuickZip)
{button ,AL(`ZIP')} See also

Use the Files page to identify the file or groups of files to zip.    If you dragged and dropped one or 
more files onto the QuickZip utility, those files are listed on this page. 
To display the Files page, click the Zip button on the QuickZip utility. Click the Files tab.

The Files page

Files to Zip
Click the Browse button to select the files to zip.    If you dragged and dropped one or more files onto 
the QuickZip utility, they are listed here.

Add 
Click to specify one or more files or a directory.    A dialog box opens in which you can enter a directory 
path.    You can use wildcards in the path to specify files.    If you enter only the directory name, such as
C:\Temp, all files in that directory will be included in your .zip file.

Zip Files in Sub-Directories
Check if you want the contents of any directories below the directory or path that you entered to be 
zipped as well.    

Remove
Select a file and click Remove to delete any items from the Files To Zip box.

Zip
Click Zip when you have completed all pages in the QuickZip dialog box (Files, Target, and Options).



Target page (QuickZip)
{button ,AL(`ZIP')} See also

Lets you enter the directory location for the .zip file (archive).
To display the Target page, click the Zip button on the QuickZip utility. Click the Target tab.

The Target page

Zip File
Enter a name for the .zip file in the box, or click the Browse button to select a name.

Make Self-Extracting File (.exe)
Check the box to create a self-extracting file (.exe).    If you create a self-extracting file using QuickZip, 
it can be opened only in Windows 3.1 and higher systems. You cannot open it in an MS-DOS 
environment. 

Path Names
Check your path name preference.

Select No Path Names if you do not want to include the file path(s) in the .zip file.
Select Store Path Names to include the file path(s) in the .zip file.

File Names
Check Use DOS (8.3) File Names for DOS and Windows 3.1 compatibility.
Check Uppercase File Names to store file names in capital letters.

Zip
Click Zip when you have completed all pages in the QuickZip dialog box (Files, Target, and Options).
Note: If you check the Use DOS option, a limitation exists:    if the first eight non-space characters of 
two or more files are identical and have the same extensions, the zipping process will not distinguish 
between them.    This means that only the last file is included in the .zip file.



Options page (QuickZip)
{button ,AL(`ZIP')} See also

Specifies the compression value and zip mode.
To display the Options page, click the Zip button on the QuickZip utility. Click the Options tab.

The Options page

Zip Mode
Click Add Files to add files to an existing .zip file or to create a new .zip file.
Click Update Files if you want to update the files in an existing .zip file. This choice replaces older

files with new versions, and, if there are any new files that do not exist in the .zip file, adds the new files.
Click Freshen Files to replace the existing files with any more recent versions.

Compression
Adjust the value:    use low or no compression to increase the speed of the zipping process and save 
time.    Use a higher compression when you want to create a small .zip file, which saves disk space 
and reduces transmission time if the .zip file is saved to a compressed drive.

Multiple Diskettes
Check this box and select a diskette drive from the drop-down list if you want to span several floppy 
diskettes with a large archive.

Password
Check the box if you want password protection, and enter a password.

Zip
Click Zip when you have completed all pages in the QuickZip dialog box (Files, Target, and Options).



Target page (Unzip)
{button ,AL(`ZIP')} See also

Specifies the directory in which to save your extracted files.
To display the Target page, click the Unzip button on the QuickZip utility. Click the Target tab.

The Target page

Target Location
Click Browse to search for a directory in which to save the extracted files.

Unzip Files
Check Unzip Only Selected Files to extract only the selected files;    check Unzip All Files to extract 
every file in the .zip file.

Unzip
Click Unzip when you have completed all pages in the Unzip dialog box (Target and Options).



Options page (Unzip)
{button ,AL(`ZIP')} See also

Specifies whether to overwrite files, create directories, and/or create a Start menu group.
To display the Options page, click the Unzip button on the QuickZip utility. Click the Options tab.

The Options page

Unzip Mode
Check Overwrite Existing Files in Target Location if you want files that are extracted from the .zip file to
replace files with the same name in the target directory.
Check Create Directories As Needed if you want any directories that are included in your archive 
automatically created for you.
Start Menu
Check Create a Start Menu Group if you want a Start Menu group automatically created for your 
unzipped files.    Enter a name for that group in the field.

Unzip
Click Unzip when you have completed all pages in the Unzip dialog box (Target and Options).



QuickZip Viewer
{button ,AL(`ZIP_USING')} See also

The QuickZip Viewer window shows you all the files that have been compressed into a .zip or .exe file.
To open the QuickZip Viewer window, drag and drop a .zip or .exe file onto the QuickZip utility or click 
the Unzip button.
Use the QuickZip Viewer menus or the toolbar buttons to change the appearance of the window 
contents and select which items to unzip. In addition, you can use the File menu and select Send Mail 
to e-mail an item.
The toolbar buttons are (from left to right):

Up One Level moves you up to the next higher folder in an archive that contains folders.    It is 
dimmed until you double-click a folder to see its contents; then you can click this button to return to the 
higher level folder.

Unzip Selected unzips the files you have selected in the Unzip window.
Unzip All unzips all files in the archive.
View Selected Files opens selected documents or text files for viewing in your default Windows 

95 viewer. 
Launch Selected Files launches files you selected.
Add Item adds files you select to the archive.
Remove Item removes one or more selected files from the archive.
Large Icons, Small Icons, Lists, and Details display the files in the archive in different formats.

When you have finished viewing the contents of the .zip or .exe file, and want to extract the 
compressed files, you can either:

Select one or more files (use Ctrl-Click to select multiple files).    Then click the Unzip Selected 
toolbar button to open the Unzip dialog box with the Unzip Selected option checked.

Click the Unzip All toolbar button to open the Unzip dialog box with the Unzip All option checked.
For more information on unzipping files, see Unzipping files.



What’s New
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_BUTTONS')} See also

View a list of items that have been tagged as changed by the QuickMarks Notification feature. For 
details about the automatic verification and notification process, see Notification.

To display the What’s New window, click the What’s New button  on the QuickMarks utility.

The What’s New window
The What’s New window displays all your changed QuickMark items, such as an Internet site that has 
changed.
You can launch an item in this window by double-clicking it. 
Note: When QuickMarks is verifying a QuickMarks button, a “secret agent” icon appears on that 

button. When you have a changed item, the What’s New button on the QuickMarks utility 
becomes animated.



Find QuickMark
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_BUTTONS')} See also

Find items in your QuickMarks by searching for titles or context strings. 
To display the Find QuickMark window, click the Find QuickMark button on the QuickMarks utility.

The Find QuickMark window

Find
Enter a context string or title. Find does not process wildcards, whole strings, or regular expressions.

Case-Sensitive Search
Searches for the context string or title with attention to capitalization.

Search Titles Only
Limits the search to the titles of QuickMarks items.

Search Titles and Contents
Searches for the titles and contents of items, such as a context string in a document.

Find
Click to start the search. If no QuickMark item matches the search criteria, a message box indicating a 
search failure is shown.
The name of the item(s), last date updated, and item type (such as Internet QuickMark) appears in the 
window.



Call Details page (InternetMeter)
{button ,AL(`MONITOR')} See also

View detailed statistics about your online communications.    

To display the Call Details page, click the Call Log button on the InternetMeter utility.    Click the Call 
Details tab. 

The Call Details window
Note: You can sort the following columns by clicking the column name.

Service Name
This column shows the name of the service provider.

Number
If telephone numbers are shown, it is either your machine’s IP address or an indication that you used 
your modem. In addition, you will see the telephone numbers for incoming calls if your telephone 
company and your hardware and system software support Caller ID.

Date and Time
This column shows the date and time of your call.

Duration
This column shows the length of your call.

Usage
This column shows what percentage of your time online was active time.    For example, if you 
launched your browser, connected to a World Wide Web page, continuously clicked different 
hyperlinks, and then logged off, you would see 100%, indicating maximum usage.

Show box and Incoming Calls For the Last box
Use the drop-down lists to filter the display:    you can view selected or all calls, filter out calls older 
than a set number of days, and include or exclude incoming calls.

Apply
Click when you have made your changes.    Until you make a change, this button is dimmed.

Print
Click to print a report of your calls.



Online Usage Report page (InternetMeter)
{button ,AL(`MONITOR')} See also

Shows a summary report of your online usage for a selected service provider.

To display the Online Usage Report page, click the Call Log button on the InternetMeter utility.    Click 
the Online Usage Report tab. 

The Online Usage Report
Select a provider from the list on the Call Details page, then click the Online Usage Report tab.    The 
name of the selected service provider is shown at the top of the Online Usage Report page.

Last Access
Shows the date and time of your last call using that service provider.

Number of Calls
Shows how many calls you have made to date using that service provider.

Total Time
Shows how much time you have spent online to date using that service provider.

Average Time Per Call
Shows the average time per online call.

Usage Per Call
Shows what percentage of your time online (using the selected service provider) was active time.    For
example, if you launched your browser, connected to a World Wide Web page, continuously clicked 
different hyperlinks, and then logged off, you would see 100%, indicating maximum usage.

Print
Click to print a copy of the online usage report.

Show box and Incoming Calls for the Last box
Use the drop-down lists to filter the display:    you can view selected or all calls, filter out calls older 
than a set number of days, and include or exclude incoming calls.

Apply
Click when you have made your changes in the filter drop-down boxes.    This button is dimmed until 
you make a change.



Call Log page (InternetMeter)
{button ,AL(`MONITOR')} See also

Lets you remove older calls from your call log file and ignore short calls. Also lets you monitor 
incoming calls.

To display the Call Log page for the InternetMeter, click the Customize button and double-click 
InternetMeter in the Plug-Ins list.    Select Settings from the list and click the Call Log tab.

The Call Log page

Minimum Duration
Select a time duration if you want the InternetMeter to ignore short calls.

Incoming Calls
Check the box if you want to monitor incoming calls such as faxes and display Caller ID. This 
functionality works only if your hardware and modem support those features, and if the latest version 
of Windows 95 telephony software (Unimodem V) is installed.
Note: In some unusual circumstances, checking this box may prevent old 16-bit communication 

applications, such as America Online and CompuServe, from dialing. If this problem occurs, 
uncheck the Incoming Calls box.

Log Maintenance
Select the number of days for which you want the InternetMeter to keep records of your older calls, 
and check the box.
Remove Calls Now
Click to remove the old calls immediately.



Save Configuration File dialog box
{button ,AL(`TASKS_GLOBAL;CONFIGURATIONS')} See also

Creates a configuration (a new setup) by saving a configuration file with a new name.

The Save Configuration File window

Save In
Specifies a folder to contain the file you want to save.

File Name
Specifies the name of the file you are saving.    Be sure to enter a unique name, unless you want to 
replace an existing configuration.

Save as Type
Specifies the type of files that appear in the list.

Save
Saves the new configuration file.



Layout Icon dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_LAYOUT')} See also

Specifies an icon for a layout.
To display the Layout Icon dialog box, click Icon in the Manage Layouts dialog box.

The Layout Icon window

Current Icon
Specifies the icon that is used by the selected layout.





Scheme page (Control Center)
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Sets preferences that control the font and color scheme for Starfish Internet Utilities.

To display the Scheme page, click the Customize button and double-click Control Center from the 
Plug-Ins list.    Select Appearance.

The Scheme page

Font
Select the font name, size, and style.    The available point sizes, which range from 6 to 12 points, and 
style, such as Bold or Italic, depend on the font that you select.    Note also that Starfish Internet 
Utilities resizes according to the font.

Color Scheme
Choose a color scheme from the drop-down list.    Click Reset to Defaults if you want to return to the 
default colors and font.



Add Sticky App dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_STICKY')} See also

Makes a running application into a sticky app.
To display the Add Sticky App dialog box, click the Customize button and select Virtual Screens on the 
Plug-Ins list.    Then click Sticky Apps on the Plug-Ins list and click Add on the Sticky Apps page.    

The Add Sticky App page 

Select a Sticky App to Add
Displays a list of running applications. Select the application that you want to designate as a sticky 
app, then click OK.



Application Task Information dialog box
Displays detailed information about a selected application in the Task Manager.    Press Ctrl+Esc to 
view the Task Manager.
To display the Application Task Information dialog box, select an application in the Task Manager and 
click the Task Info button.



Browse dialog box
Lets you navigate to locate a file.
To display the Browse dialog box, click the Browse button, which appears in several of the Starfish 
Internet Utilities dialog boxes, such as the QuickRun dialog box.

The Browse dialog box

Look In
Specifies the folder that contains the desired file.

File Name
Specifies the name of the desired file. Click the file name in the list or type it here.

Files of Type
Specifies the type of files that appear in the list.

Open
Enters the name of the selected file in the dialog box.



Change Icon dialog box (Printers utility)
{button ,AL(`PRINTER_PANEL;PRINTER_PANEL_CONFIGURING')} See also

Changes the icon Starfish Internet Utilities uses in the Printers utility for the selected printer.
To display the Change Icon dialog box, click the Customize button and select Printers from the Plug-
Ins list.    Click Settings, and then click the Settings tab. Click the Change Icon button.

The Change Icon page 

Current Icon
Specifies the icon used in the Printers utility by the selected printer.    To change the icon, click a 
different icon in the Current Icon box.    The change will become effective immediately.



Select Icon dialog box (QuickMarks)
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_BUTTONS')} See also

Changes the icon Starfish Internet Utilities uses for a button in the QuickMarks utility.
To display the Select Icon dialog box, right-click any QuickMarks button and click Change Icon on the 
shortcut menu.

The Select Icon page 

File
Specifies the name and path of the file that contains the icon you want to use. Changing the file here 
will not change the file used to launch this program.

Browse
Lets you browse in a different directory to select the icon you want to use.
When you have found an icon that you like, select it from the box and click the OK button.



QuickRun dialog box
{button ,AL(`DASH_RUN')} See also

Performs DOS commands and starts programs.
To display the QuickRun dialog box, click  on Internet Utilities.

The QuickRun dialog box

Command Line
Specifies a command or program to run. Type the name of the command or program, or choose it from
the drop-down history list.

Run
Runs the command or program displayed in the Command Line box.

Run Minimized
Minimizes the window that contains the running command or program.

Done
Closes the QuickRun dialog box.

Browse
Lets you browse to enter the name and path of the program you want to run.



Task Manager
Lets you manage applications in the following ways:

Switch between currently running applications.
Close a running application.
Tile or cascade currently running applications.
Display memory usage information about a running application.

To display the Task Manager, press Ctrl+Esc.

The Task Manager

Task List
Displays a list of currently running applications that are not minimized.

Minimized Applications
Displays a list of currently running applications that are minimized.

Switch To
Select a program from the Minimized Applications or Task List and click to activate that program.    Or, 
double-click the program name in either list.

Task Info
Select a program from either list and click Task Info to view detailed information about that program.

Close Selected
Select an application and click Close Selected to close that application.

Tile
Tiles the applications that share Virtual Screens.

Cascade
Cascades applications that share Virtual Screens.

Arrange Icons
Depending on your version of Windows 95 or Windows NT, rearranges all minimized icons in every 
Virtual Screen according to available space.



Edit Layout dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_LAYOUT')} See also

Changes the preferences of a program used in a layout, including the file name, working directory, and
so on.
Starfish Internet Utilities saves the information displayed in this dialog box automatically when you 
create a layout. You can use the Edit Layout dialog box to change this information. Starfish Internet 
Utilities uses this new information to run programs when you use the Load Layout command.
To display the Edit Layout dialog box, select a program and click Edit in the Save Layout dialog box or 
the Manage Layouts dialog box.

The Edit Layout dialog box 

Application Name
Specifies a name for the program. This is a descriptive name, not a file name.

Command Line
Specifies the file name of the program.

Working Directory
Specifies the working directory used by the program.

Parameters
Specifies any command line parameters needed to run the program. For example, if you want a file to 
open when the program starts, enter the file path and name here.

Window Size
Specifies the initial display size of the window containing the program.



Manage Layouts dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_LAYOUT')} See also

Lets you delete and rename layouts, and delete and edit the preferences of programs used in the 
layout.
To display the Manage Layouts dialog box, choose Manage Layouts from the Layout menu: 

The Manage Layouts dialog box 

Layout
Displays the layouts already created.

Delete
Deletes the selected layout. Select the layout you want to delete in the Layout list, and then click 
Delete.

Rename
Renames the selected layout. Select the layout you want to rename in the Layout list, then click 
Rename to display the Rename Layout dialog box.

Icon
Specifies the icon to use when the layout is displayed on the Layouts group of the Quick Launch 
panel.

Applications
Displays applications used in the selected layout.

Delete
Removes the selected application from the selected layout. Select a layout in the Layout list, select the
application you want to delete in the Applications list, and then click Delete.

Edit
Changes the preferences of the selected application in the selected layout. Select a layout in the 
Layout list, select the application you want to edit in the Applications list, and then click Edit to display 
the Edit Layout dialog box.

Load Selected Layout on Startup
Specifies whether to load the selected layout when Starfish Internet Utilities starts.

Save Changes
Saves any changes to the layout and closes the dialog box.



Save Layout dialog box
{button ,AL(`EXT_SCREENS;EXT_SCREENS_LAYOUT')} See also

Lets you save the programs currently running as a Starfish Internet Utilities layout.
To display the Save Layout dialog box, choose Save Layout from the Layout menu: 

The Save Layout dialog box

Enter a Name for this Layout
Specifies the name of the layout. If you accept the default name, the layout is named "Default".

Load Layout on Startup
Specifies whether to load the layout when Starfish Internet Utilities starts.
If you check this option, you can still start Starfish Internet Utilities without loading the layout: Hold 
down the Shift key while Starfish Internet Utilities loads.

Programs for this Layout
Displays the programs used in the layout you are saving.

Edit
Lets you change the preferences of the programs used in the layout you are saving. Select a program 
in the Programs for this Layout list, and then click Edit to display the Edit Layout dialog box.

Delete
Removes the selected application from the layout you are saving. Select a program in the Programs 
for this Layout list, and then click Delete.



Customize dialog box
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Use the Customize dialog box to specify your Starfish Internet Utilities preferences.
To open the Customize dialog box, do one of the following:

Right-click any utility or the Internet Utilities title bar and choose Customize from the shortcut 
menu.

Click 

The Customize dialog box lets you specify your preferences for each utility.
The Plug-Ins list on the left side of the Customize dialog box lists all the currently installed plug-in 
utilities on Starfish Internet Utilities.    When you select a utility from the Plug-Ins list on the left, you’ll 
see its Customize page displayed on the right. This page describes the features of that utility and 
allows you to show it or hide it.    For example, if you select QuickMarks from the Plug-Ins list, its top-
level page will be displayed on the right, describing its ability to give you quick access to your 
programs and favorite Internet sites.
When you double-click a utility in the list, the list expands to show that utility’s Customize sections.    
For example, when QuickMarks is highlighted in the Plug-Ins list, you can see that it has two 
Customize sections: Settings and Notification. You can click on either to change those aspects of the 
QuickMarks utility.



Setup page
{button ,AL(`TASKS_GLOBAL;CONFIGURATIONS')} See also

Lets you change your current Control Center setup.
To view the Setup page, click the Customize button and select My Setup from the Plug-Ins list. My 
Setup is the default file name; each time that you change to a different setup file, that file name 
appears. Click the Setup tab.

The Setup page 

Current Setup
Displays a drop-down list of default and saved setups from which to choose.

To add a new setup to the Current Setup list
Click Save to save and name your current setup.

Delete
Deletes a selected setup from the Current Setup list.

Link Setup to Windows Log On
Associates setup selection with user names.    This means that each user can use a different setup that
will be linked to that user name.    If it is unchecked, only one setup can be chosen, regardless of the 
user’s name.



Plug-Ins page
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also
Lets you add and remove plug-in utilities from Starfish Internet Utilities.    When you remove a plug-in 
utility as described here, the plug-in utility is removed from both view and memory.    You can also hide 
a plug-in utility from view only but keep it in memory.    For details, see Showing and hiding utilities.
To display the Plug-Ins page, click the Customize button and then click My Setup (or the current setup 
file name) in the Plug-Ins list on the left.    Click the Plug-Ins tab.

To add a plug-in utility
1. Select the plug-in utility from the Available Plug-Ins list.
2. Click Add.

To remove a plug-in utility from view and memory
1. Select the plug-in utility from the Installed Plug-Ins list.
2. Click Remove.

The Plug-Ins page 
Available Plug-Ins
Displays plug-in utilities that have been removed from view and memory.

Installed Plug-Ins
Displays plug-in utilities that are in use on Starfish Internet Utilities.

Add
Adds a selected plug-in utility from the Available Plug-Ins list to Starfish Internet Utilities.

Remove
Removes a selected plug-in utility from the Installed Plug-Ins list from view and memory.



Control Center page
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Sets preferences that control the overall appearance and behavior of the Internet Utilities Control 
Center.

To display the Control Center page, click the Customize button and select Control Center from the 
Plug-Ins list.

The Control Center page

Replace Windows Task Manager
Replaces the Windows Task Manager with the Task Manager.

Enable ToolTips
If checked, displays ToolTips for every feature on Starfish Internet Utilities.

Title Bar
Select the contents of the title bar from the list.    The title bar appears only when Starfish Internet 
Utilities position is set to floating.    Options available include the Resources details. 



Position page (Control Center)
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Sets preferences that control the position of Starfish Internet Utilities. In addition, lets you minimize the 
space needed by the Control Center with a unique feature: SlimView. In SlimView, only the QuickMark 
tabs are displayed. You can also use the Position page to have Internet Utilities stay in front of other 
windows.

To display the Position page, click the Customize button and double-click Control Center in the Plug-
Ins list. Select Arrangement from the Plug-Ins list, and then click the Position tab.

The Position page

Control Center Position
Check the preferred position:

Floating in horizontal or vertical position
“Docked” to an edge of the screen like a toolbar.

Options
Check SlimView to display only the QuickMark tabs. This choice is allowed only when the Control 

Center is docked. (To restore the Control Center to full size, click a tab or the Control Center’s edge.)
Check Always in Front to have Internet Utilities always appear in front of other windows, even if 

another window is active.
Check Attach to System Tray if you want Internet Utilities to appear as an icon in the Windows 95 

taskbar system tray when it is minimized.



Snap Off page
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Sets preferences that control which plug-in utilities are snapped off the Control Center.

To display the Snap Off page, click the Customize button and double-click Control Center in the Plug-
Ins list.    Select Arrangement, and then click the Snap Off tab.

The Snap Off page

Snap-Off Plug-Ins
Check the boxes next to the plug-in utilities that you want to snap off.    You can snap off the 
InternetMeter, QuickMarks, Printers, and/or Taskbar plug-in utilities.
Snap-Off Minimization
Check to have snapped-off plug-in utilities minimize when you minimize Internet Utilities.



Effects page (Control Center)
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Customizes the appearance of the Control Center to suit your personal working style.

To display, click the Customize button and double-click Control Center from the Plug-Ins list. Select 
Appearance. Click the Effects tab.

The Effects page

Show Highlights
If checked, when you move your mouse over the Control Center, the controls are highlighted.

Show Tabs
To display the QuickMark tabs in SlimView, check Show Tabs. If you do not check this box, only a thin 
gray bar appears at the edge of your screen. (To restore the Control Center to full size, click a tab or 
move the mouse over the gray bar.)

Slide the Control Center
Check to have the Control Center slide into place when it is in SlimView. If you do not check this box, 
the Control Center pops up when you change views.



Hot Keys page (Control Center)
{button ,AL(`TASKS_GLOBAL;DASH_PREFS')} See also

Sets preferences that set the hot key sequences for activating Starfish Internet Utilities, QuickRun, or 
the Windows 95 Explorer.

To display the Hot Keys page, click the Customize button and double-click Control Center in the Plug-
Ins list. Select Hot Keys.

The Hot Keys page

Keyboard Activation
You can use certain keys in combination, such as Ctrl, Alt, and Shift.

When you type the hot key for Starfish Internet Utilities, the Windows Explorer, or QuickRun, it is 
displayed in front of all other windows, or, if it is already in front, moves behind all other windows.
To clear the existing hot key, press Delete or backspace over the hot key.



QuickMarks page
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_APPEARANCE')} See also

Lets you choose whether to show the QuickMarks plug-in utility on Starfish Internet Utilities.
To display the QuickMarks page, click the Customize button and select QuickMarks from the Plug-Ins 
list.



Settings page (QuickMarks utility)
{button ,AL(`QUICK_LAUNCH')} See also

Specifies the type of buttons displayed in the QuickMarks utility, and allows you to change the interval 
for auto-saving your QuickMarks. You can also select a browser to use when launching QuickMarks. In
addition, in some cases, verification checks need to go through a proxy server to get outside of a 
firewall. Use the Advanced Settings dialog, described below, to specify a server name and port 
number.

To display the Settings page, click the Customize button and double-click QuickMarks in the Plug-Ins 
list. Select Settings from the Plug-Ins list and click the Settings tab.

The Settings page

Button Style
Specifies the type of button that appears in the QuickMarks groups:

Unlabeled Large Icons displays only icons.
Labeled Large Icons and Labeled Small Icons display icons with the program names.

Auto-Save
To change the interval for auto-saving your QuickMarks, use the drop-down list.

Advanced…
To change the browser that is used for launching Internet QuickMarks buttons or to use a proxy server,
click the Advanced button:

Use the Advanced Settings Browser page to select the browser you want to use when launching 
QuickMarks. Click Netscape Navigator or Microsoft Internet Explorer.

Use the Advanced Settings Proxy page to specify a server name and port number.



Position page (QuickMarks utility)
{button ,AL(`QUICK_LAUNCH;QUICK_LAUNCH_APPEARANCE')} See also

Lets you change the position of the QuickMarks utility.    You can also choose to enable SlimView.    To 
display the Position page, click the Customize button and double-click QuickMarks in the Plug-Ins list.  
Select Settings in the list, and then click the Position tab.

The Position page

QuickMarks Position
Change the placement of your QuickMarks utility in your window.    You can snap it onto Starfish 
Internet Utilities or snap it off as a floating toolbar.    Alternatively, you can dock it to an edge of your 
screen.

Options
Check Enable SlimView to reduce the size needed by the QuickMarks utility.
Check Always in Front if you want the QuickMarks utility always to be in front of other windows.



Notification page (QuickMarks utility)
{button ,AL(`QUICK_LAUNCH')} See also

Lets Starfish Internet Utilities periodically check your QuickMarks and notify you if any are updated or 
moved (such as a discontinued Internet site).

To display the Notification page, click the Customize button and double-click QuickMarks in the Plug-
Ins list. Then select Notification in the list.

The Notification page

Check QuickMarks
Use the Check QuickMarks Every n Minutes box to determine how frequently Starfish Internet Utilities 
checks your QuickMarks.    Use the Check Only While Online box to have the verification process 
occur only while you are online (for example, during a Web browsing session).

Changes
Determines whether updated QuickMarks are shown with a starburst and removed QuickMarks are 
shown with an X.
Select an alarm sound from the drop-down list if you want an alarm to notify you of all QuickMark 
changes.

Filters
Check Ignore Broken Links to have broken Internet links ignored.    If you do not check this box, 
Starfish Internet Utilities will search for every missing link on all your Internet sites.
Check Ignore Changes Older Than box and enter a number of days in the drop-down list to speed up 
verification and have Starfish Internet Utilities log only changes that are more recent than the selected 
number of days.
Note: When QuickMarks is verifying a QuickMarks button, a “secret agent” icon appears on that 

button. When you have a changed item, such as a Web site that has new contents, the What’s 
New button  on the QuickMarks utility becomes animated. You can see all your changed items 
by opening the What’s New window of QuickMarks.



WinTools page
{button ,AL(`WIN_TOOLS')} See also

Choose whether to display the WinTools utility on Starfish Internet Utilities.
To display the WinTools page, click the Customize button and select WinTools from the Plug-Ins list.

The WinTools page 
Check the box to show the WinTools utility on Starfish Internet Utilities.



Tools page
{button ,AL(`WIN_TOOLS')} See also

Lets you select Windows 95 tools to display on the WinTools utility.

To display the Tools page, click the Customize button and double-click WinTools in the Plug-Ins list. 
Then select Tools from the list.

The Tools page 

Available Tools
To add a tool to the WinTools utility, select the tool from this list and click Add.

Installed Tools
To remove a tool from the WinTools utility, select the tool from this list and click Remove.



Resources dialog box
{button ,AL(`RESOURCES')} See also

Contains information about your memory, Windows system resources, and system environment. Use 
the Resources dialog box to examine resource usage and to set alarm levels for low resources.
To display the Resources dialog box, do one of the following:

Double-click the Resources utility.
Right-click the Resources utility and choose Details.

The Resources dialog box

Select Item to View
Lists the types of resources and system information that Starfish Internet Utilities monitors. Select an 
item in the list to display information about it.

Memory Watch
System Environment
Drive Watch
Environment Variables
Applications Running

Print
Prints the information you are viewing in the Resources dialog box.



Memory Watch
{button ,AL(`RESOURCES_GAUGE')} See also

Displays statistics about memory and Windows system resources, and lets you set alarms to warn you
about declining resources.
To display this information, click Memory Watch in the Select Item to View list in the Resources dialog 
box.
The Memory Watch information is also available in the Customize dialog box. 

The Memory Watch page 

System Memory
Displays the total memory, the used memory, and the free memory in kilobytes and as a percent of 
total memory.

GDI Memory
Displays the total GDI memory, the used GDI memory, and the free GDI memory in kilobytes and as a 
percent of the total.

User Memory
Displays the total user memory, the used user memory, and the free user memory in kilobytes and as a
percent of the total.

Notification 
Sounds an alarm to warn you when free memory falls below a specific percentage of the total memory.

Alarm Sound
Plays the selected sound. Choose a sound for the alarm, then click the button to test the sound.



System Environment
{button ,AL(`RESOURCES')} See also

Displays information about the system environment, such as CPU type, monitor type, mouse, 
keyboard, network, output port, and output devices installed under Windows.
To display this information, click System Environment in the Select Item to View list in the Resources 
dialog box.



Drive Watch
{button ,AL(`RESOURCES')} See also

Displays statistics about your disk drives, such as total disk space, used disk space, and available disk
space. The information includes floppy drives, hard disk drives, and network drives.
To display this information, click Drive Watch in the Select Item to View list in the Resources dialog 
box.
The Drive Watch information is also available in the Customize dialog box.

The Drive Watch page 

Drive
Displays the list of available floppy drives, hard disk drives, and network drives.

Total
Displays the total amount of disk space on each drive in megabytes.

Used
Displays the amount of used disk space on each drive in megabytes.

Free
Displays the amount of free disk space on each drive in megabytes.

% Free
Displays the percent of free disk space on each drive.

Refresh List
Refreshes the displayed drive usage information.

Update Interval
Specifies the time interval, in seconds, between updates to the drive usage information on the 
Resources utility.

Start Watch/End Watch
Select a drive and enter a time interval in the Update Interval box. Click Start Watch to begin 
monitoring; click End Watch to end the monitoring session.



Applications Running
{button ,AL(`RESOURCES')} See also

Displays a list of currently running applications and their memory usage. The list is sorted according to 
the amount of memory used by each application.
To display this information, click Applications Running in the Select Item to View list in the Resources 
dialog box.

The Applications Running page 

Refresh
Refreshes the displayed application and memory information.

Close Application
Closes the selected application. Select an application in the list, then click Close Application.



Environment Variables
{button ,AL(`RESOURCES')} See also

Displays information about environment variables.
To display this information, click Environment Variables in the Select Item to View list in the Resources 
dialog box.



Resources page
{button ,AL(`RESOURCES')} See also

Lets you select whether to show the Resource Monitor utility on the Starfish Internet Utilities Control 
Center and which components you want visible.

To display the Resources page, click the Customize button and select Resources from the Plug-Ins 
list.

The Resources page 
Check the Show the Resources Monitor box to display the Resources utility.

Resource Gauges
Check the components that you want displayed.
To change the Memory Watch appearance, select a new gauge type from the drop-down list.



Memory Watch page
{button ,AL(`RESOURCES')} See also

Displays statistics about memory and Windows system resources, and lets you set alarms to warn you
about declining resources.

To display the Memory Watch page, click the Customize button and double-click Resources in the 
Plug-Ins list.    Then select Memory Watch from the list.

The Memory Watch information is also available in the Resources dialog box.

The Memory Watch page 

System Memory
Displays the total memory, the used memory, and the free memory in kilobytes and as a percent of 
total memory.

GDI Memory
Displays the total GDI resources, the used GDI resources, and the free GDI resources in kilobytes and
as a percent of the total.

User Memory
Displays the total user resources, the used user resources, and the free user resources in kilobytes 
and as a percent of the total.

Notification
Sounds an alarm to warn you when system memory and/or any memory area fall below a specific 
level. Enter the alarm point in the % Free boxes.

Alarm sound
Change the selected sound. 



Drive Watch page
{button ,AL(`RESOURCES_DRIVES')} See also

Displays statistics about your disk drives, such as total disk space, used disk space, and available disk
space. The information includes floppy drives, hard disk drives, and network drives.

To display the Drive Watch page, click the Customize button and double-click Resources from the 
Plug-Ins list.    Then select Drive Watch from the list.

The Drive Watch information is also available in the Resources dialog box.

The Drive Watch page 

Drive
Displays a list of available floppy drives, hard disk drives, and network drives.

Total
Displays the total amount of disk space on each drive in megabytes or gigabytes.

Used
Displays the amount of used disk space on each drive in megabytes or gigabytes.

Free
Displays the amount of free disk space on each drive in megabytes or gigabytes.

% Free
Displays the percent of free disk space on each drive.

Refresh List
Updates the displayed information.

Update Interval
Enter a new number in the box to specify the time interval, in seconds, between updates to the drive 
usage information.

Start Watch
Lets you monitor the free space on a drive. Select a drive from the Drive list, enter the update interval, 
and then click Start Watch.
End Watch
Click to end the monitoring session.



InternetClock page
{button ,AL(`CLOCK_CALENDAR')} See also

Lets you display and hide the InternetClock on Starfish Internet Utilities.

To display the InternetClock page, click the Customize button and select InternetClock from the Plug-
Ins list.

Check the box to show the InternetClock on Starfish Internet Utilities. Uncheck the box to hide it from 
view.





attrib
Displays or sets the attributes (read-only, archive, system, hidden) of files.

Syntax
attrib [+r|-r] [+a|-a] [+s|-s] [+h|-h ] [[drive:][path]filename] [/s]



call
Transfers control from one batch file to another until that batch file ends, returning control to the first 
batch file.

Syntax
call [drive:][path]filename [batch-parameters]



cd (chdir)
Changes the directory or displays the name of the current directory.

Syntax
cd [drive:] [path]
cd[..]
chdir [drive:] [path]
chdir[..]



cls
Clears the screen and the command line, as well as removing all previous output from the output 
window.

Syntax
cls



copy
Copies a file from one location to another or combines files.

Syntax
copy [/a|/b] source [/a|/b] [+source[/a|/b] [+ ...]] [destination [/a |/b]] [/v]



date
Changes the system date.

Syntax
date [month-day-year]



del (erase)
Erases a file or group of files.

Syntax
del [drive:] [path] filename [/p] [/s]
erase [drive:] [path] filename [/p] [/s]



dir
Lists the files and subdirectories in a directory.

Syntax
dir [drive:] [path] [filename] [/p] [/w] [/a[[:]attributes]] [/o[[:]sortorder]] [/s] [/b] [/l]



echo
Determines whether commands are displayed as they are executed from the command prompt or from
a batch file.

Syntax
echo [off|on]
echo [message]



edit
Opens the specified text file in the Windows WordPad application.

Syntax
edit [[drive:][path]filename] 



exit
Closes the QuickRun dialog box.

Syntax
exit



find
Searches for a string of characters or numbers within a specified file or files.

Syntax
find [/v] [/c] [/n] [/i] "string" [[drive:][path]filename]



for
Allows you to perform a command on a set of files.

Syntax
When used in a batch file:
for %%variable in set do command [command-parameters]
When used at the command prompt:
for %variable in set do command [command-parameters]



goto
Transfers execution in a batch program to a specified line, rather than the next line in the batch 
program.

Syntax
goto label



help
Loads the help system.

Syntax
help [<command name>]



if
Tests whether a condition is true before carrying out a command. (If the condition is false, the specified
command is not executed.)

Syntax
if [not] errorlevel number command
if [not] string1==string2 command
if [not] exist filename command



label
Displays or changes the volume label assigned to a floppy disk or hard drive.

Syntax
label [drive:] [label]



md (mkdir)
Creates a subdirectory on the specified drive.

Syntax
md [drive:]path
mkdir [drive:]path



path
Determines where to look for executable files (.exe, .com, .bat, and .pif) and documents.

Syntax
path
path [=] [[drive:][path][;...]]



pause
Suspends execution of a batch file until the user presses a key or clicks a mouse button.

Syntax
pause



print
Allows you to print a file to the current printer.

Syntax
print [[drive:][path]filename[...]]



prompt
Determines how the command prompt is displayed.

Syntax
prompt [text]



rd (rmdir)
Removes the directory specified by <dirname>.

Syntax
rd [drive:][path]
rmdir [drive:][path]



rem
Precedes comments in batch files.

Syntax
rem [comment]



ren (rename)
Renames files or directories.

Syntax
ren [drive:][path] filename1|directoryname1 filename2|directoryname2
rename [drive:][path] filename1|directoryname1 filename2|directoryname2



set
Displays, sets, or deletes DOS environment variables.

Syntax
set [variable=[string]]



shift
Allows a user to specify more than ten parameters on the command prompt for a batch file by 
replacing the contents of the first parameter (%0) with the contents of the second (%1) and shifting 
each subsequent parameter down in similar fashion.



sort
Sorts input and writes the output to a device or file.

Syntax
sort [/r] [/+n] [<] [drive1:][path1]filename1 [>[drive2:][path2]filename2]
[command|]sort [/r] [/+n] [>[drive2:][path2]filename2]



time
Displays or sets the system time.

Syntax
time [hh:mm]ss:[.xx]][a|p]]



type
Displays the contents of an ASCII text file within the Windows Prompt Edit Control output windows.

Syntax
type [drive:][path]filename



ver
Displays the version of your operating system and the version of Windows Prompt Edit Control.

Syntax
ver



vol
Displays the label and serial number assigned to a drive.    If no drive is specified, the current drive is 
used.

Syntax
vol [drive:]



xcopy
Copies files, using all memory made available by Microsoft Windows.

Syntax
xcopy source [destination] [/a|/m] [/d:date] [/p] [/s [/e]] [/w]



Browsing the Internet
{button ,AL(`INTERNET')} See also

Starfish Internet Utilities includes a variety of World Wide Web-related QuickMarks tabs, such as 
Search, with six to ten QuickMarks buttons in each category. When you install Starfish Internet Utilities,
it also automatically imports your Internet “Bookmarks,” if you are using Netscape Navigator, and/or 
“Favorites,” if you are using Microsoft Internet Explorer. You’ll find special Bookmarks and/or Favorites 
tabs already provided on QuickMarks. Internet Utilities automatically synchronizes your Bookmarks 
and Favorites for you. Or, if you prefer, you can manually synchronize them.

To connect with an Internet site in a QuickMarks group
Click the site’s QuickMarks button. If your default browser is not already running, clicking the button 
launches the browser automatically. Your browser then connects to that site. After your browser is 
launched, you can continue to click different QuickMarks buttons to connect quickly to those sites. To 
change the browser used to launch your QuickMarks buttons, see the Settings page.
You can create additional Internet buttons quickly and easily. For details, see Adding Internet 
QuickMarks buttons.



Adding Internet QuickMark buttons
{button ,AL(`INTERNET')} See also

You can add Internet QuickMark buttons using either the QuickMark It! button , or a method offered 
by some browsers.

To add an Internet QuickMark button with the QuickMark It! button
1. Start your QuickMark default browser (Netscape Navigator or Microsoft Internet Explorer).
2. Connect to the page for which you want a QuickMark button.
3. Click the QuickMark It! button.

To add an Internet QuickMark button from your browser
1. In your browser, right-click a Web site that you want to save, and then select Internet Shortcut from 

the browser’s pop-up menu.
(This Windows 95 shortcut method works only with 32-bit browsers, such as Netscape Navigator 
and Microsoft Internet Explorer. Please note that these methods do not work as described with all 
versions of those browsers.)

2. Click OK in the Create Internet Shortcut dialog box. This creates a shortcut, represented by a globe-
shaped icon, which appears on the desktop.

3. Drag the shortcut to an appropriate Internet QuickMarks group. For example, if the shortcut 
represents a site for a news magazine, you could drag it to the News group.

In addition, with some browsers, you can select and then drag and drop an individual .gif (graphics file)
or hyperlink from a Web page to a QuickMarks group.
Tip: You can assign a representational icon to each QuickMarks button by customizing it.



Customizing QuickMarks button icons
{button ,AL(`INTERNET')} See also

To change the icon of a QuickMarks button
1. Right-click the QuickMarks button and select Change Icon from the shortcut menu.
2. Click Browse.
3. The Select Icon File dialog opens, displaying the Icon Gallery.    Choose an appropriate graphic, and

click that icon. 



Monitoring your Internet usage
{button ,AL(`INTERNET')} See also

Use the InternetMeter to keep track of your online communications, such as browsing and searching 
the Web, dialing a BBS, or sending a fax.    The InternetMeter works with almost all 32-bit Windows 95 
applications, such as Netscape Navigator, Microsoft Internet Explorer, Microsoft Fax, and Hyperterm.    
Note: The InternetMeter works only with 32-bit communications utilities, such as Netscape Navigator 

2.0, Microsoft Internet Explorer, and Spry Mosaic.    It does not work with 16-bit browsers or 
communications utilities.

For details on using the InternetMeter and Call Log window, see About the InternetMeter. 



QuickMarking Your Current Web Page
{button ,AL(`INTERNET')} See also

Use Starfish Internet Utilities’ unique QuickMark It! button  to create Internet QuickMark buttons with
a single mouse click. Now you don’t need to worry about bookmarking your favorite sites, or taking the 
time to follow your browser’s procedures for creating a shortcut. Let the QuickMark It! button do the 
work.

To QuickMark a Web page
1. Start your QuickMark default browser (Netscape Navigator or Microsoft Internet Explorer).
2. Connect to the page for which you want a QuickMark button.
3. Click the QuickMark It! button.



About QuickZip
{button ,AL(`ZIP_USING')} See also

Use QuickZip to compress a group of files into an archive and extract compressed files.    These tasks 
are often referred to as “zipping” and “unzipping” files.

You can create both .zip files and self-extracting files (.exe) just by dragging and dropping files 
onto the QuickZip utility.

You can unzip files either by dragging and dropping them onto the QuickZip utility or just by 
clicking the Unzip button and entering the name of any .zip file on your system into a dialog box.

Note: If you check the Associate QuickZip with the .ZIP Extension box on the QuickZip Customize 
page, you can double-click an attached .zip file in MS Exchange to open it in the Zip Viewer 
window. In addition, you can double-click a .zip file on a Web page in Netscape Navigator or 
Microsoft Internet Explorer (version 2.0 or higher), and open that .zip file in the Zip Viewer 
window. If it is a large file, the downloading process before the Zip Viewer window opens with 
the .zip file displayed may be time-consuming.

For more information, see Zipping files and Unzipping files.



Showing and hiding the QuickZip utility
{button ,AL(`ZIP_USING')} See also

To show or hide the QuickZip utility
1. Click  to open the Customize dialog box.

2. Click QuickZip in the Plug-Ins list.
3. Check or uncheck the Show QuickZip box.



Changing the Zip settings
{button ,AL(`ZIP_USING')} See also

To change the Zip settings
1. Click  to open the Customize dialog box.

2. In the Plug-Ins list, double-click QuickZip.
3. Check the Associate QuickZip with the .ZIP Extension box to use QuickZip from a file’s shortcut 
menu.
4. In the Plug-Ins list, click Settings, and then click the Zip tab.    After you change your preferences 
on this page, the modified settings become the default.    This means that the next time you use the 
QuickZip utility, the changes you made will appear in the Zip dialog box settings.    The Zip page options 
are:

Zip Sub-Directories
Store Paths
Use DOS (8.3) File Names
Uppercase File Names
Default Zip Mode
Compression



Changing the Unzip settings
{button ,AL(`ZIP_USING')} See also

To change the Unzip settings
1. Click  to open the Customize dialog box.

2. Double-click QuickZip in the Plug-Ins list. 
3. Check the Associate QuickZip with the .ZIP Extension box to use QuickZip from a file’s shortcut 
menu.
4. In the Plug-Ins list, select Settings, and click the Unzip tab. After you change your preferences on 
this page, the modified settings become the default.    This means that the next time you use the QuickZip 
utility, the changes you made will appear in the Unzip dialog box settings.    The Unzip page options are:

Overwrite Existing Files
Create Directories as Needed
Path for Temporary Files



Zipping files
{button ,AL(`ZIP_USING')} See also

To create a zip file
1. Do one of the following:

Drag and drop one or more files onto the QuickZip utility.
Click the Zip button.

2. The Zip dialog box opens, containing three pages:    Files, Target and Options.    Fill in the fields for 
these pages in the above order. When you have completed your entries, click the Zip button on the 
Options page.

Check the Associate QuickZip with the .ZIP Extension box on the QuickZip page in Customize to use 
QuickZip from a file’s shortcut menu.



Unzipping files
{button ,AL(`ZIP_USING')} See also

To unzip a file
1. Do one of the following:

Drag and drop a .zip file or self-extracting .exe to the QuickZip utility. (You can unzip a self-
extracting .exe file without help from Internet Utilities just by double-clicking it. However, by using 
QuickZip, you can first see the contents of the .exe file and decide which files to uncompress.)

Click the Unzip button on the QuickZip utility, and select a .zip or self-extracting .exe file from the 
Open File dialog box.

2. The QuickZip Viewer window opens and displays the contents of your .zip or self-extracting .exe file.
Use the QuickZip Viewer toolbar buttons and menus to perform tasks ranging from adding and 
removing items to viewing the contents of the archive in different formats, such as large icons and 
details. You can also e-mail an item by selecting an item, opening the File menu, and selecting Send
Mail.
When you are ready to extract the compressed files, either:

select one or more files (use Ctrl-Click to select multiple files).    Then click the Unzip Selected 
toolbar button to open the Unzip dialog box with the Unzip Selected option checked.

click the Unzip All toolbar button to open the Unzip dialog box with the Unzip All option checked.
3. The Unzip dialog box opens, containing two pages:    Target and Options. Fill in the fields for these 

pages in the above order.    When you have completed your entries, click the Unzip button on the 
Options page.

Note: If you check the Associate QuickZip with the .ZIP Extension box on the QuickZip Customize 
page, you can double-click an attached .zip file in MS Exchange to open it in the Zip Viewer 
window. In addition, you can double-click a .zip file on a Web page in Netscape Navigator or 
Microsoft Internet Explorer (version 2.0 or higher), and open that .zip file in the Zip Viewer 
window. If it is a large file, the downloading process before the Zip Viewer window opens with 
the .zip file displayed may be time-consuming.



About the QuickZip Viewer
{button ,AL(`ZIP_USING')} See also

The QuickZip Viewer window shows you all the files that have been compressed into a .zip or .exe file.
To open the QuickZip Viewer window, drag and drop a .zip or .exe file onto the QuickZip utility or click 
the Unzip button. Use the QuickZip Viewer menus or the toolbar buttons to change the appearance of 
the window contents and select which items to unzip. In addition, you can use the File menu and 
select Send Mail to e-mail an item.
The toolbar buttons are (from left to right):

Up One Level moves you up to the next higher folder in an archive that contains folders.    It is 
dimmed until you double-click a folder to see its contents; then you can click this button to return to the 
higher level folder.

Unzip Selected unzips the files you have selected in the Unzip window.
Unzip All unzips all files in the archive.
View Selected Files opens selected documents or text files for viewing in your default Windows 

95 viewer. 
Launch Selected Files launches files you selected.
Add Item adds files you select to the archive.
Remove Item removes one or more selected files from the archive.
Large Icons, Small Icons, Lists, and Details display the files in the archive in different formats.

When you have finished viewing the contents of the .zip or .exe file, and want to extract the 
compressed files, you can either:

Select one or more files (use Ctrl-Click to select multiple files).    Then click the Unzip Selected 
toolbar button to open the Unzip dialog box with the Unzip Selected option checked.

Click the Unzip All toolbar button to open the Unzip dialog box with the Unzip All option checked.
For more information on unzipping files, see Unzipping files.



About the InternetClock 
{button ,AL(`CLOCK_CALENDAR')} See also

The InternetClock lets you schedule alarms, reminders, and tasks, and display up to four clocks, each 
showing the time in a different time zone. It also includes an Internet Time Synchronizer, which 
precisely synchronizes your computer’s system clock with Internet time servers, ensuring that your 
system time is accurate and reliable.
You can:

automatically reset your computer’s system clock by linking to an Internet time server that uses 
the Network Time Protocol (NTP).

schedule single or recurring reminders for events and tasks.
set alarms, and optionally select a snooze interval. You can set an alarm to go off on a recurring 

basis or for one time only.
arrange up to four clocks on the InternetClock, each displaying a different label and time zone.



About reminders
{button ,AL(`CLOCK_CALENDAR')} See also

Starfish Internet Utilities reminders can help you keep track of your busy schedule. Click the Reminder 
button  on the InternetClock to set an alarm that will remind you of an appointment. You can repeat 
the same reminder every day or on a specific day of the week, and you can set a reminder weeks or 
months in advance.

How reminders are displayed
A reminder appears on screen as a message box. You can click OK to close the reminder box, or click 
Snooze to close the box for a specified snooze interval. If you do not close the reminder box within an 
hour, it closes automatically.
To change the chime sound and snooze interval for reminders, click the Customize button, double-click
InternetClock, and click Events. On the Options page, select the Reminder Chime you want. 
You can also set reminders to appear as an icon in the Windows 95 system tray, instead of in a pop-up
window, by checking Show Reminder Icon in System Tray on the Options page. When the reminder 
appears in your system tray, click the Reminder icon to see the message.
To adjust the volume and duration of the alarm sound, use the volume control in the system tray or the 
Multimedia program in the Windows 95 Control Panel.
Note: Reminders appear only when Starfish Internet Utilities is running.



About alarms
{button ,AL(`CLOCK_CALENDAR')} See also

You can set an alarm to remind you about an event or to start a computer task automatically.    You can
repeat the same alarm every day or on a specific day of the week, and you can set an alarm weeks or 
months in advance.

How alarms are displayed
When an alarm goes off, an alarm box appears showing the date and time. Click OK to close the box. 
If you do not close the alarm box within an hour, it closes automatically.
You set the alarm sound for a non-message alarm in the InternetClock Alarm dialog box. To adjust the 
volume and duration of the alarm sound, use the volume control in the Windows 95 system tray or the 
Multimedia program in the Windows 95 Control Panel.
Note: These alarms appear only when Starfish Internet Utilities is running.



About task alarms
{button ,AL(`CLOCK_CALENDAR')} See also

Starfish Internet Utilities task alarms can start programs that you want to run periodically to perform 
particular tasks. You set a task alarm to launch an application. You can repeat the same alarm every 
day or on a specific day of the week, and you can set an alarm weeks or months in advance.

How task alarms work
At the scheduled alarm time, the application starts.
Note: Task alarms work only when Starfish Internet Utilities is running.



Showing and hiding the InternetClock 
{button ,AL(`CLOCK_CALENDAR')} See also

To show or    hide the InternetClock 
1. Click  to open the Customize dialog box.

2. Click InternetClock in the Plug-Ins list.
3. Check or uncheck the Show box.

You can also show or hide individual clocks on the InternetClock. 



Adding and removing clocks
{button ,AL(`CLOCK_CALENDAR')} See also

To display another clock on the InternetClock utility
1. Click  to open the Customize dialog box.

2. Double-click InternetClock and click Settings.
3. On the Clocks page, click the Add button.
4. Enter a time zone and a caption.

To remove a clock from the InternetClock utility
1. Click  to open the Customize dialog box.

2. Double-click InternetClock and click Settings.
3. On the Clocks page, select the clock that you want to remove and click the Remove button.

You can also hide the entire InternetClock utility.



Setting your computer's date and time
{button ,AL(`CLOCK_CALENDAR;CLOCK_CALENDAR_SYNCH')} See also

To set your system date or time, do one of the following
Click the date below the clock.
Click the Customize button. Double-click InternetClock and click Settings. On the Clocks page, 

click Set Date/Time.



Specifying an analog or digital clock
{button ,AL(`CLOCK_CALENDAR_APPEARANCE')} See also

To change the clock style to analog or digital
Click the Customize button. Double-click InternetClock and click Settings. On the Appearance 

page, select a clock and choose Analog Clock Face or Digital Clock Face.
The analog clock shows the time with the hour and minute hands pointing to numbers (with an optional
second hand), and the digital clock represents time as a number.
Note: If you’re using a communication program that has a time-out feature, turn the Second Hand 

option off to avoid a time-out every time the clock repaints the second hand.



Choosing a clock face
{button ,AL(`CLOCK_CALENDAR_APPEARANCE')} See also

To choose a clock face
1. Click  to open the Customize dialog box.

2. Double-click InternetClock, and click Settings.
3. Click the tab for the Appearance page.
4. In the Clock Face list, select a clock and click Analog Clock Face or Digital Clock Face. Choose 
the clock option you want from the drop-down list.

As you click the names of the clock faces, Starfish Internet Utilities displays the clock face in the 
clock face area on the right.



Showing or hiding the clock's second hand
{button ,AL(`CLOCK_CALENDAR_APPEARANCE')} See also

When an analog clock is displayed, you can show or hide the second hand.

To show or hide the clock's second hand
1. Click  to open the Customize dialog box.

2. Double-click InternetClock and click Settings. 
3. On the Appearance page, select a clock and check or uncheck Show Second Hand.

Note: The second hand might interfere with some communication programs. If your communication 
program is experiencing unnecessary time-outs, try hiding the second hand.



Setting a reminder
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also

To set a reminder
1. Click the Reminder button  on the InternetClock to open the InternetClock Reminder dialog box.

2. In the Date section, choose a single date or schedule the reminder to repeat daily, weekly, or 
monthly. To set a date, use the arrows or type a number in the box.
3. In the Time section, choose the time and time zone for the reminder, or set it to repeat every so 
many minutes. To set a time, use the arrows or type a number in the box.
4. In the Reminder section, type the reminder message in the box.

To view reminders, click the Customize button. Double-click InternetClock, and click Events in the 
Plug-Ins list. Click the Events tab to see your reminders.



Setting an alarm
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also

To set an alarm
1. Right-click the InternetClock and choose Schedule Alarm to open the InternetClock Alarm dialog 

box.
2. In the Date section, choose a single date or schedule the alarm to repeat daily, weekly, or monthly. 

To set a date, use the arrows or type a number in the box.
3. In the Time section, choose the time and time zone for the alarm, or set it to repeat at intervals. To 

set a time, use the arrows or type a number in the box.
4. In the Alarm section, choose the sound you want for the alarm. To preview the sound, click the

 button.
To view alarms, click the Customize button. Double-click InternetClock, and click Events in the Plug-
Ins list. Click the Events tab to see your alarms.



Scheduling a task with an alarm
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also

To set an alarm to run a program automatically
1. Right-click the InternetClock and choose Schedule Task to open the InternetClock Task dialog box.
2. In the Date section, choose a single date or schedule the task to repeat daily, weekly, or monthly. To 

set a date, use the arrows or type a number in the box.
3. In the Time section, choose the time and time zone for the task, or set it to repeat at intervals. To set

a time, use the arrows or type a number in the box.
4. In the Task section, enter the name, directory path, and, optionally, a command-line parameter for 

starting it. You can click the Browse button to find the program you want.
5. Check the Run Minimized box if you want the program to run minimized.
To view program task alarms, click the Customize button. Double-click InternetClock, and click Events 
in the Plug-Ins list. Click the Events tab to see your scheduled program task alarms.



Changing a reminder, alarm, or task
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also

To change an event (reminder, alarm, or task)
1. Right-click the InternetClock and choose Customize from the shortcut menu.
2. Click Events. 
3. Select the event to change and click Modify.
4. Change the event details in the Modify Event dialog box.
To view events, click the Customize button. Double-click InternetClock, and click Events to see your 
scheduled reminders, alarms and tasks.



Setting the snooze interval
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also

When a reminder message box displays, you can click Snooze to close it temporarily. The reminder 
box will appear again after a set number of minutes known as the snooze interval.

To set the snooze interval
1. Right-click the InternetClock and choose Customize from the shortcut menu.
2. Click Events.
3. Click the Options tab.
4. In the Snooze For box, type the number of minutes for the snooze interval, or use the arrows to 

raise or lower the current value.



Showing reminders in the system tray
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also

By default, reminders appear as pop-up messages on your screen, but you can set them to appear as 
reminder icons in the Windows 95 system tray. Then when the chime alerts you, you click the reminder
icon to see the message.

To set reminders to appear as icons in the system tray
1. Right-click the InternetClock and choose Customize from the shortcut menu. 
2. Click Events.
3. Click the Options tab.
4. Click Show Reminder in System Tray.



Choosing an alarm sound for reminders
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also

To choose a sound for reminders
1. Right-click the InternetClock and choose Customize from the shortcut menu.
2. Select InternetClock in the Plug-Ins list, and then click Events.
3. Click the Options tab.
4. In the Reminder Chime section, select the sound you want to alert you when the reminder appears. 

To hear the sound, click the Play  button.



Deleting a reminder, alarm, or task
{button ,AL(`CLOCK_CALENDAR_ALARM')} See also

To delete an event (reminder, alarm, or task)
1. Right-click the InternetClock and choose Customize from the shortcut menu.
2. Click Events to view your scheduled reminders, alarms, and tasks.
3. Select the event to delete and click Remove. 
Note: You can also disable temporarily all recurring events without deleting them. To do this, check the

Disable Recurring Events box on the Events page in the Customize dialog box.



About the Internet Time Synchronizer
{button ,AL(`CLOCK_CALENDAR')} See also

The Internet Time Synchronizer precisely synchronizes your computer’s system clock by linking to an 
Internet time server that uses the Network Time Protocol (NTP).    You need either a modem or network
Internet connection to synchronize your system time.
For more details on the Time Synchronizer, right-click the Time Synchronizer icon in the system tray 
and select Help from the shortcut menu.





About the InternetMeter
{button ,AL(`MONITOR')} See also

Use the InternetMeter to keep track of your online communications, such as browsing and searching 
the Web, dialing a BBS, or sending a fax. The InternetMeter works with almost all 32-bit Windows 95 
applications, such as Netscape Navigator, Microsoft Internet Explorer, Microsoft Fax, and Hyperterm. 
(The InternetMeter works only with 32-bit communications utilities, such as Netscape Navigator 2.0, 
Microsoft Internet Explorer, and Spry Mosaic.)
Note: Even after you exit from Starfish Internet Utilities, the background monitoring component of the 

InternetMeter module continues to record your online activities. It is loaded whenever Windows 
starts, and is represented by a small icon in the system tray of the Windows 95 taskbar. When 
Internet Utilities is not running, you can right-click this icon and select Close InternetMeter from 
the shortcut menu to stop the background monitoring and remove the icon. When you restart 
Windows 95, that icon will again be displayed.

As you conduct an online communication, the InternetMeter displays:
the progress of your online activity, either by displaying your modem status lights or input/output 

progress. For details on changing this display, see Changing the InternetMeter display.
the current action (such as “connecting”)
number of bytes sent and received
elapsed hours, minutes, and seconds for the current call. Click the scroll arrows on either side to 

see the time accumulated online by day, by month, and by year.

To view a complete log of all your online connections in the Call Log window, click the Call Log  
button.
Note: Online and Internet service providers vary in their policies concerning their billing practices, 

such as in their methods for rounding up the hours spent or billing in minimum time increments. 
They also may change their policies. InternetMeter does not account for all such variables. 
Although InternetMeter will reflect the actual time spent online, that time may not correspond to 
your final bill from your service provider. 



Using the Call Log window
{button ,AL(`MONITOR')} See also

Click the Call Log button  on the InternetMeter to analyze your previous online sessions and print 
detailed reports of your online communications with almost all 32-bit Windows 95 applications, such as
Netscape Navigator 2.0 and higher and Microsoft Internet Explorer 2.0 and higher.

The Call Log window contains two pages: Call Details, which allows you to view detailed statistics about 
your online communications, and Online Usage Report, which displays a summary report of your online 
usage for a selected service provider.

Note: You can remove entries of calls from your log file that are older than a certain number of days.    
For details, see the Call Log page in Customize.



Showing and hiding the InternetMeter
{button ,AL(`MONITOR')} See also

To show or hide the InternetMeter
1. Click  to open the Customize dialog box.

2. Click InternetMeter in the Plug-Ins list.
3. Check or uncheck the Show box on the InternetMeter page.



Changing the InternetMeter display
{button ,AL(`MONITOR')} See also

To change the InternetMeter display
1. Click  to open the Customize dialog box.

2. Double-click InternetMeter in the Plug-Ins list, and then click Settings in the Plug-Ins list.
3. Click the Settings tab.
4. In the Connection Display area, check whether you prefer:

Modem Display, which shows modem lights.
Histogram Display, which shows a graphical representation of online input and output progress.



Changing your modem or calling location
{button ,AL(`MONITOR')} See also

You can change your modem and/or location information.

To change your modem and/or location information
Right-click the InternetMeter and select Set Up Location and/or Set Up Modem from the shortcut 
menu:

Set Up Location opens the Windows Control Panel Dialing Properties dialog box, where you can 
specify your location and dialing details.

Set Up Modem opens the Windows Control Panel Modem Properties dialog box, where you can 
change your modem information.

See your Windows documentation for details on these dialog boxes.



Changing the appearance of the InternetMeter
{button ,AL(`MONITOR')} See also

You can change the position and size of the InternetMeter.

To change the size and position of the InternetMeter
1. Right-click the InternetMeter and select either:

full size, which will provide greater detail about your online connection
compact size, which will save space on the Control Center.

2. Click Position, and then select whether you prefer to have the InternetMeter:
snapped onto the Control Center
snapped off and floating. If you choose this option, you can also select Always in Front if you want

the InternetMeter to appear in front of other windows when it is snapped off.



Modifying the service provider list
{button ,AL(`MONITOR')} See also

Use the Services page if you want to add or remove a service provider. Or, if the name of a service 
provider is too long to fit on the screen or in your logs, you can specify a shortened display name. You 
also have the option of turning off call logging for a selected service provider.

To add to the service provider list or specify a shortened name
1. Click  to open the Customize dialog box.

2. Double-click InternetMeter in the Plug-Ins list and then select Services in the Plug-Ins list.
3. Click the Services tab.
4. Click Add to enter the name of a new service provider.
5. In the Service Name section, enter the name of the online service and an optional short name 
that will be displayed on the InternetMeter.    (If you want only to enter a shorter name for a service 
provider, select that service provider first from the Online Services section.    Then enter the shorter name 
in the Service Name section.)



Monitoring your online service provider time
{button ,AL(`MONITOR')} See also

If your online service provider limits your free time, use the InternetMeter to track your hours and 
remind you when you have used up your free time.

To monitor your online service provider time
1. Click  to open the Customize dialog box.

2. Double-click InternetMeter in the Plug-Ins list and then select Services in the Plug-Ins list.
3. Click the Free Time tab.
4. Select a service provider from the Online Services list.
5. In the Free Time section, enter the time you have accumulated with the selected service provider 
and the billing start date.

When you want to check how much free time you have left, you can view your remaining hours on this 
page.



Identifying a service provider
{button ,AL(`MONITOR')} See also

With some applications, such as some versions of Hyperterm, the InternetMeter cannot determine the 
name of the provider you are using.    Instead, it will show you the    name of the application (.exe) that 
has launched the call or connection.    In such situations, use the Identification page to identify the 
service provider by entering either the application name without a path or the telephone number that 
you use to connect to that service provider.

To identify a service provider
1. Click  to open the Customize dialog box.

2. Double-click InternetMeter in the Plug-Ins list and then select Services in the Plug-Ins list.
3. Click the Identification tab.
4. Select a name from the Online Services list.
5. If needed because of an application you are using, enter its .exe in the Application field.    Or, 
enter the telephone number(s) that you use to connect to that provider.



Cleaning up your log file and ignoring short calls
{button ,AL(`MONITOR')} See also

You can have the InternetMeter remove older calls from your call log file.    In addition, you can have 
the InternetMeter ignore short calls.

To clean up your log file and ignore short calls
1. Click  to open the Customize dialog box.

2. Double-click InternetMeter in the Plug-Ins list and then select Settings in the Plug-Ins list.
3. Click the Call Log tab.
4. Select a time interval from the Minimum Duration drop-down list to have the InternetMeter ignore 
short calls.
5. Enter the number of days to keep records of your older calls, and check the box.

Note: You can remove the older calls immediately by clicking the Remove Calls Now button.



Using the InternetMeter system tray icon menu
{button ,AL(`MONITOR')} See also

You can change your modem and/or location information, get information about your Internet 
configuration, view the Call Log box, and close the InternetMeter system tray icon with the 
InternetMeter icon shortcut menu.

To use the InternetMeter icon shortcut menu
Right-click the InternetMeter and select:

Open Call Log to use the InternetMeter Call Log.
Set Up Location to open the Windows Control Panel Dialing Properties dialog box, where you can

specify your location and dialing details.
Set Up Modem to open the Windows Control Panel Modem Properties dialog box, where you can

change your modem information. 
Internet Info to view technical details about your Internet configuration and your network adapters.

(See your Windows documentation for details on the Location, Modem, and Internet dialog boxes.) 
Close InternetMeter when Internet Utilities is not running to stop the background monitoring and 

remove the icon.    When you restart Windows 95, that icon will again be displayed.






